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Every effort was made to ensure that the information in this document was 
accurate at the time of printing. However, information is subject to change 
without notice, and Softing IT Networks GmbH reserves the right to provide an 
addendum to this document with information not available at the time that this 
document was created.

© Copyright 2017 Softing IT Networks GmbH. All rights reserved. Softing IT 
Networks GmbH, and its logo are trademarks. All other trademarks and registered 
trademarks are the property of their respective owners. No part of this guide 
may be reproduced or transmitted electronically or otherwise without written 
permission of the publisher.

Softing IT Networks GmbH and FiberXpert OTDR 5000 (applied for trademarking) 
are trademarks or registered trademarks of Softing IT Networks GmbH.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet Explorer 
are either trademarks or registered trademarks of Microsoft Corporation in the 
United States and/or other countries.

Specifications, terms, and conditions are subject to change without notice. 
All trademarks and registered trademarks are the property of their respective 
companies.

Softing IT Networks GmbH has established processes in compliance with the 
Waste Electrical and Electronic Equipment (WEEE) Directive, 2002/96/EC. 

This product should not be disposed of as unsorted municipal waste and should be 
collected separately and disposed of according to your national regulations. In the 
European Union, all equipment purchased from Softing IT Networks GmbH after 
2005- 08-13 can be returned for disposal at the end of its useful life. Softing IT 
Networks GmbH will ensure that all waste equipment returned is reused, recycled, 
or disposed of in an environmentally friendly manner, and in compliance with all 
applicable national and international waste legislation.

It is the responsibility of the equipment owner to return the equipment to Softing 
IT Networks GmbH for appropriate disposal. If the equipment was imported by a 
reseller whose name or logo is marked on the equipment, then the owner should 
return the equipment directly to the reseller.

Instructions for returning waste equipment to Softing IT Networks GmbH can be 
found in the Environmental section of Softing IT Networks GmbH’s web site at 
http://itnetworks.softing.com

NOTICE:

COPYRIGHT:

TRADEMARKS:

WEEE DIRECTIVE
COMPLIANCE:
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ABOUT THIS GUIDE
The FiberXpert OTDR 5000 of Softing IT Networks GmbH provides a handheld OTDR for the 
construction, turn-up and maintenance of fiber networks.

The topics discussed in this chapter are as follows:

– “Purpose and scope”
– “Assumptions”
– “Technical assistance”
– “Conventions”
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PURPOSE AND SCOPE
The purpose of this guide is to help you successfully use the FiberXpert OTDR 5000 features and capabilities. 
This guide includes task-based instructions that describe how to install, configure, use, and troubleshoot the 
FiberXpert OTDR 5000.

Additionally, this guide provides a complete description of Softing IT Networks GmbH’s warranty, services, 
and repair information, including terms and conditions of the licensing agreement.

ASSUMPTIONS
This guide is intended for novice, intermediate, and experienced users who want to use the FiberXpert 
OTDR 5000 effectively and efficiently. We are assuming that you have basic computer and mouse/track ball 
experience and are familiar with basic telecommunication concepts and terminology.

TECHNICAL ASSISTANCE
If you need assistance or have questions related to the use of this product, call or e-mail Softing IT Networks
GmbH’s Technical Assistance Center for customer support.

Region Phone Number

Europe, Africa, and Mid-East
+49 (89) 891360 60 (Europe)
+33 01 45 17 28 05
Softing SARL

support.itnetworks@softing.com
info.france@softing.com
itnetworks.softing.com

Asia / Pacific +65 6569 6019 (Singapore)

DURING OFF-HOURS, YOU CAN REQUEST ASSISTANCE BY 
DOING ONE OF THE FOLLOWING:
• leave a voice mail message at the Technical Assistance number in your region
• e-mail Technical Assistance Center, support.itnetworks@softing.com
• submit your question using our online Technical Assistance Request form at http://itnetworks.softing.com
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CONVENTIONS
This guide uses naming conventions and symbols, as described in the following tables.

Table 2 Typographical conventions

Description Example
User interface actions appear in this typeface. On 
the Status bar, click Start. On the Status bar, click Start.

Buttons or switches that you press on a unit 
appear in this TYPEFACE. Press the ON switch.

Code and output messages appear in this 
typeface. All results okay

Text you must type exactly as shown appears in 
this type- face. Type: a:\set.exe in the dia- log box

Variables appear in this type- face. Type the new hostname
Book references appear in this typeface. Refer to Newton’s Telecom Dictionary
A vertical bar | means “or”: only one option can 
appear in a single command. platform [a|b|e]

Square brackets [ ] indicate an optional argument. login [platform name]
Slanted brackets < > group required arguments. <password>

Table 3 Keyboard and menu conventions

Description Example
A plus sign + indicates simultaneous keystrokes. Press Ctrl+s
A comma indicates consecutive key strokes. Press Alt+f,s
A slanted bracket indicates choosing a submenu 
from menu. On the menu bar, click Start > Program Files.

Table 4 Symbol conventions

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

NOTE
This symbol represents a Note indicating related information or tip.

This symbol, located on the equipment or its packaging indicates 
that the equipment must not be disposed of in a land- fill site or 
as municipal waste, and should be disposed of according to your 
national regulations.
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Table 4 Symbol conventions

WARNING
Indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, may result 
in minor or moderate injury.

1-FIBERXPERT OTDR 5000 OVERVIEW
This chapter provides a general description of the FiberXpert OTDR 5000. Topics discussed in this chapter 
include the following:

• “Unpacking the instrument”
• “About the FiberXpert OTDR 5000”
• “Main features”
• “Hard keys and Indicators”
•  “Power Supply”

Unpacking the instrument
1 Remove the FiberXpert OTDR 5000 and its accessories from the packing case.
2 Check that the module and accessories ordered are all there.
If any part is missing or damaged please contact your local Softing IT Networks GmbH 
agent. The FiberXpert OTDR 5000 is delivered as standard with:

Table 4 Symbol conventions

A Getting Started Manual
A Li-Polymer battery, set into the equipment and which must be charged before use
A mains adapter used for mains operation of the instrument and battery charging
5 country adaptable plugs (Europe / UK / US / Australia / Japan) A hands-free soft case 
for the FiberXpert OTDR 5000
A USB cable, to connect the FiberXpert OTDR 5000 to PC
A shoulder strap
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About the FiberXpert OTDR 5000
The architecture of the FiberXpert OTDR 5000 is made of one Platform, to which a 
module is added to perform tests on fiber networks.
The module is fitted to the FiberXpert OTDR 5000
The FiberXpert OTDR 5000 employs multi-tasking for the simultaneous performance of 
several operations:
– acquisitions
– modifications of parameters
– trace analysis
– report management
It also allows to use simultaneously several functions:
– Power Meter
– Scope
– OTDR measurements

Main features
The FiberXpert OTDR 5000 is equipped with the following elements:
– A 5 inch TFT color touchscreen, high visibility
– RJ45 plug for Ethernet interface
– Two USB 2.0 host connectors for Microscope, USB memory stick, mouse, keyboard...
– One mini USB 2.0 device connector to connect the FiberXpert OTDR 5000 to a PC
– An audio jack to connect a headset
– A connection socket for the mains adapter providing the 12 V power supply and used 
to charge the battery.
– LED indicators for Charge, On status and Test
– A Li-Polymer battery
With the FiberXpert OTDR 5000, the user can:
– Open/transfer files to a PC via a USB memory stick, USB cable
– Generate pdf reports
– Open all user documentations on the FiberXpert OTDR 5000
– Update the FiberXpert OTDR 5000 firmware
– Remote the screen of the FiberXpert OTDR 5000 onto a PC and issue commands 
from the keyboard of the PC
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Soft keys perform the 
function on the display 
above each button.

Indicators

Hard keys Loudspeaker

TFT 5’’ Color
Touchscreen

Indicators

RJ45 USB host Power
Meter

VFL Mini USB
Device

AC/DC
Input

Headset
jack

Fig. 1 FiberXpert OTDR 5000 with module

Fig. 2 FiberXpert OTDR 5000: Front view

Fig. 3 FiberXpert OTDR 5000: Connectors View
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HARD KEY FUNCTION
Main on/off switch

This button calls up the file explorer. It allows to:
– choose the storage medium: internal memory, USB memory key.
– manage files; with facilities for classifying them in directories and sub-directories.
Gives access to:
– selection of the different measurement or functions
– the settings of the instrument
– the help page

This button calls up the measurement configuration menu. This menu depends on the 
function in use.

This button allows to deselect a function or escape a menu

Starts and stops the measurement.

This button calls up the results page (with OTDR module: reflectometry trace and table 
of results).

The direction keys have two principal functions:
– on the Results page, they are used to move the cursors or modify the zoom factor.
– on the set-up pages, they are used to scroll through the menus, the central button 
serving to select or confirm the parameter chosen.

Fig. 4 Hard keys and Indicators

HARD KEYS AND INDICATORS
Front panel hard keys

Table 2 Hard keys description
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Front panel indicators
The FiberXpert OTDR 5000 is equipped with three indicators, lit into a different color
according to the status of the unit

Table 3 Indicators Status

Power Supply
The FiberXpert OTDR 5000 may operate with
– the Li-Polymer battery, already set into the equipment on delivery.
– an AC adapter/charger, via a power cable on which has been set the correct country ad

On indicator

Blinking green The instrument, though connected to an external power source, is 
switched off.

Solid green The instrument is operating, either by battery or on an external 
power supply.

Charge
indicator

Solid green The instrument is connected to an external power source and the 
battery is fully charged.

Solid red The instrument is connected to an external power source, and the 
battery is on charge.

Testing
indicator

Solid red At least one function is in measurement phase (for example, the 
laser emission pilot for an OTDR measurement)
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Power supply plug

Interchangeable plugs

UK adaptable
plug
(installed by
default)

EUROPE
adaptable
plug

US
adaptable
plug

JAPAN
adaptable plug

AUSTRALIA
adaptable plug
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2-SAFETY INFORMATION
This chapter gives the main information on the safety conditions when using the FiberXpert OTDR 5000:

• “Battery and AC/DC safety information”
• “Precautions relating to optical connections”
• “Laser Safety instructions”

Battery and AC/DC safety information

– The Li-Polymer battery is designed for maximum safety.
In particular, each cell is provided with a safety valve to prevent exces- sive internal 
pressure in the event of overcharging or exposure to very high temperatures.

– Battery supplied by Softing IT Networks GmbH incorporate protection means. Do 
not use any mains adaptor or battery other than those supplied with the instrument, 
or supplied by Softing IT Networks GmbH as an option for this instrument.

If another adapter or battery is used, it may damage the FiberXpert OTDR 5000 itself.

Using the FiberXpert OTDR 5000 with a battery other than the one supplied by the 
manufacturer of the FiberXpert OTDR 5000 may entail risks of fire or explosion.

The battery may explode, leak or catch fire:
– if it is exposed to high temperature or fire
– if it is opened or dismantled.

Other basic safety precautions are as follows:

– Do not use AC/Adapter/Charger outdoors or in wet or damp locations

– Connect the AC/Adapter/Charger to the correct mains voltage, as indicated on the 
ratings label.

– Do not allow anything to rest on the power cord, and do not locate the product 
where people can walk on the power cord.

– Avoid using this product during an electrical storm. There may be a remote risk of 
electric chock from lightning.

– Do not use this product in the vicinity of a gas leak or in any explo- sive environment.

– Do not attempt to service this product yourself, as opening or removing covers may 
expose you to dangerous, high voltage points and other hazards. Contact qualified 
service personnel for all service.

Precautions relating to optical connections

– The normal operating life of an optical connector is usually of the order of a few 
hundred manipulations. It is then advisable to manip- ulate the optical connections of 
the Platform as rarely as possible.
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– The proper operation of the instrument and its accuracy of measurement are 
dependent on the cleanliness of the environment and the optical connectors as well as 
the care taken in its manipulation.
– The optical connectors must therefore be clean and dust-free. If the optical 
connection is not being used, protect the connections of FiberXpert OTDR 5000 using 
the protective caps.

Laser Safety instructions
The provisions contained in two standards define the safety procedures to be 
observed both by users and by manufacturers when utilizing laser products:
– EN 60825-1: 2001 - Safety of laser products – Part 1: Classification of products, 
requirements and user guidelines.
– FDA 21 CFR § 1040.10 - Performance standards for light-emitting products - Laser 
products.
Due to the range of possible wavelengths, power values and injection characteristics 
of a laser beam, the risks inherent in its usage vary. The laser classes form groups 
representing different safety thresholds.

Laser classes
Standards EN 60825-1, Edition 1.2, 2001-08 and FDA21CFR§1040.10:
– VFL option: Class 2.

Warning labels for the laser classes
Due to the reduced dimensions of the optical modules, it is not possible to attach the 
required warning labels to them. In line with the provisions of Article 5.1 of the EN 
60825-1 standard, the laser class identification labels are shown below:
– EN 60825-1: 2001 - Safety of laser products – Part 1: Classification of products, 
requirements and user guidelines.
– FDA 21 CFR § 1040.10 - Performance standards for light-emitting products - Laser 
products.

Reference standard EN 60825-1, Edition 1.2, 2001- 08 FDA21CFR§1040.10
Class 1 CLASS 1 LASER PRODUCT

Class 2
LASER RADIATION
DO NOT STARE INTO BEAM
CLASS 2 LASER PRODUCT

CAUTION
LASER RADIATION -
DO NOT STARE INTO BEAM
CLASS II LASER PRODUCT

The user must take the necessary precautions concerning the optical
output of the instrument and follow the manufacturer’s instructions.
Measurements on optical fibers are difficult to execute and the precision of 
the results obtained depends largely on the precautions taken by the user.
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Setting the adaptable plug to the mains adapter

The FiberXpert OTDR 5000 is supplied as standard with a mains adapter and 5 country 
adaptable plugs (Europe / UK / US / Australia/Japan).

To set the correct plug to the mains adapter:

1 Make flush the connector onto the mains adapter with the adaptable plug slots.

2 Push the adaptable plug until it stops.

Connecting the mains adapter

1 Set the appropriate adaptable plug to the power supply cable, according to your 
country.

2 At the right side of the FiberXpert OTDR 5000, lift up the power supply socket 
protector and plug in the mains adapter.

3 Connect the adapter to the mains.

The On indicator lamp starts to blink in green.

Use only the mains adapter supplied with the FiberXpert OTDR 5000. The adapter for 
some other electronic device may appear to be identical, but entails a risk of damage 
to the FiberXpert OTDR 5000.

3-STARTING UP

Fig. 6 Setting the adaptable plug onto the mains adapter

If the adapter plug is not correctly set onto the mains adapter,  the connector may be damaged.
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First use

At the delivery, the battery is already set into the Unit, but its charge level is not
«recognized» by the equipment.

The icon  is displayed on the upper banner of the screen.

To get a valid indication of the battery, and be able to use correctly the Platform:

1 Charge fully the battery

2 Once fully charged, discharge the battery by keeping the Unit switched on, but not 
plugged to mains.

3 The battery can then be charged, and the Unit used simultaneously.

Charging the battery

On connection to the mains:

– if the user does not press ON, the battery will start the charge. In this case, the 
Charge indicator will be lit in red.

– when the user presses the ON key, the instrument starts up and the battery will 
charge during use (Charge indicator in solid red).

Once the battery is fully charged, the Charge indicator is lit in solid green.

When the Charge indicator is blinking red, this mean the power supply is not 
compatible with the battery used. Charge is disabled.

It is essential to wait until charging is complete to ensure maximum independent 
operating time, which may otherwise be considerably reduced.

Battery charging time

If the battery is completely discharged, the time taken to recharge is:

– approximately 3.5 hours, if the apparatus is not in use (Charge indi- cator solid red)

– about 9.5 hours if the instrument is used during charging (On indi- cator lit in fix 
green, Charge indicator lit in solid red).

Battery charge level display

When the battery is installed in the instrument, a battery icon is displayed in the top 
righthand corner of the screen. Example: 

– if the user does not press ON, the battery will start the charge. In this case, the 
Charge indicator will be lit in red.

– when the user presses the ON key, the instrument starts up and the battery will 
charge during use (Charge indicator in solid red).
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Once the battery is fully charged, the Charge indicator is lit in solid green.

When the Charge indicator is blinking red, this mean the power supply is not 
compatible with the battery used. Charge is disabled.

Charging the battery

The battery capacity is superior to 75%

The battery capacity is set between 50% and 75%

The battery capacity is set between 25% and 50%

The battery capacity is inferior to 25%

The battery capacity is unknown. Perform a full charge/ discharge of the battery to 
get back to a valid indication. This icon may appear if battery is changed or if the 
battery auto discharges at a very low level (example: if a Unit switches off as battery 
is empty, and the charge is not done during several months (= auto discharge)).

– When the level becomes too low, the instrument emits a beep ton inform the 
user until it switches off automatically after saving the current configuration and 
measurement.

Table 4 Battery icons

SWITCHING THE FIBERXPERT OTDR 5000 ON AND OFF
Switching on

Press the ON/OFF key.

If the Unit is powered to mains, the battery will charge. The On indicator pass from 
blinking to solid green.

The startup logo appears on the screen briefly, then an auto test is carried out.

The equipment is ready to be used once all the applications are installed.

NOTE
It is possible to switch over from battery to mains operation, or vice versa, without 
loss of data.

The module cannot be swapped when the unit is ON or AC powered

In the event of an unexpected mains power cut, if there is no battery, the current 
results and configuration will not be saved. Next time the instrument is switched on, it 
will return to its initial configuration.
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Switching off

While the FiberXpert OTDR 5000 is operating, press the ON/OFF button to switch it 
off.

NOTE
When the instrument is switched off using the ON/OFF button, current results and 
configuration are saved. Next time the ON/OFF key is pressed, they are recalled.

Resetting the FiberXpert OTDR 5000

If the FiberXpert OTDR 5000 freezes, prolonged pressure (about 4 s.) on the ON/ OFF 
key will reset the instrument.

Setting the adaptable plug to the mains adapter

The FiberXpert OTDR 5000 is supplied as standard with a mains adapter and 5 country
adaptable plugs (Europe / UK / US / Australia/Japan).

To set the correct plug to the mains adapter:

1 Make flush the connector onto the mains adapter with the adaptable plug slots.

2 Push the adaptable plug until it stops.

First start: configuring your regional settings

Once the FiberXpert OTDR 5000 is switched on, the first screen displayed allows to 
configure
the regional settings.

Those settings will be kept in memory and automatically applied on the instrument 
each time it is restarted.

Fig. 7 Regional Settings



28 https://itnetworks.softing.com

Fiber pert
O TDR 5000

1 Click on Language and select the language to be used for the equipment.

2 Click on Date and enter the current date, using the numeric keypad displayed using 
the menu key Edit Number.

3 Click on Time and enter the current time, using the numeric keypad displayed using 
the menu key Edit Number.

The date and time are displayed on the upper right side of the screen.

4 Click on Date Time Format and configure the following parameters:

– Date format: select one of the option dd/mm/yy or mm/dd/yy.

– Time format: select one of the option 24 hour clock or 12 hour clock.

5 Click on Net Time parameter to configure the date and time according to a network.

Dynamic Mode: the time is synchronized according to the local network.

The two lines Server Name are displayed but cannot be modified.

Static Mode: in this case, the time is synchronized to the network server which is 
defined in the two following parameters.

On the parameter Address Type, select if the address of the server which will be used 
for synchronization is entered via its IP Address or via the Server Name..

If IP Address is selected, enter one or two server addresses in the following 
parameters. During synchronization, the first address will always be used, but if a fail 
occurs, the second one will be used.

If Server Name is selected, enter the name of the server, and if necessary a name for 
second server. During synchronization, the first server name will always be used, but if 
a fail occurs, the second one will be used.

During synchronization the icon displays on the upper banner between the date and 
time.

6 Once all parameters have been defined, press Exit menu key to return to System 
Settings page.
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Displaying the System Settings screen

To display the System Settings screen, you must:

1 Press the HOME hard key to reach the Home page.

4-CONFIGURING THE FIBERXPERT OTDR 5000
This chapter describes the operations for configuring the instrument. The topics discussed in this chapter 
are as
follows:
• “Displaying the System Settings screen”
• “Defining the screen parameters of the FiberXpert OTDR 5000”
• “Defining the Audio parameters of the FiberXpert OTDR 5000”
• “Defining the Automatic shutdown of the FiberXpert OTDR 5000”

Fig. 8 Home page

2 Activate the Settings icon  to open the System Settings screen.

Fig. 9 System Settings page
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NOTE
If you are in the Regional Settings page, and you press Exit, then the System Settings 
page automatically displays.

Defining the screen parameters of the FiberXpert OTDR 5000

In the System Settings page, the following parameters can be defined:

Backlight

1 Click on Backlight

2 Define the backlight level of the screen, using the left and right direction keys, or 
clicking on Edit Number softkey and using the keypad displayed.

– Min backlight level: -5

– Max backlight level: +5

If the FiberXpert OTDR 5000 is operating on battery, it is advisable to choose a 
minimum lighting level, acceptable for the user, to keep endurance as long as possible 

Contrast

1 Click on Contrast

2 Select the type of environment into which the instrument is used:

– Indoor: to be selected when the instrument is used inside

– Outdoor: to be selected in order to optimize the readability of the screen for an 
outside use.
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Screen Saver

Click on Screen Save if you wish to activate a screen saver to the equip- ment, to 
extend the life of the battery, in case the FiberXpert OTDR 5000 is not used for some 
time.

Instead of the normal screen, a small animated picture of the Unit is displayed on the 
blackened screen.

To configure the screen saver:

1 Click on Delay and select the time of inactivity before the screen saver starts: 60s, 3 
min, 5 min.

The parameter No deactivates the screen saver function.

Defining the Audio parameters of the FiberXpert OTDR 5000

In the Audio box of the System Settings screen, you can configure the audio 
parameters according you are using a headset with the Unit.

1 Adjust the volume on the line Hands-free Volume using the left and right direction 
keys, or the Numeric keypad (displayed with the softkey Edit Number)
– Min volume for Hands-free function: 0
– Max volume for Hands-free function: 100

2 If a headset is used, adjust the volume on the line Headset Volume, using the left 
and right direction keys, or the Numeric keypad (displayed with the softkey Edit 
Number):
– Min volume for Headset function: 0
– Max volume for Headset function: 10 0

Fig. 10 Example of outdoor contrast
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Defining the Automatic shutdown of the FiberXpert OTDR 5000

The automatic shutdown function switches off the FiberXpert OTDR 5000 
automatically if no operation has been performed and no key actuated for a period 
selected from this menu. Work in progress is automatically saved.

The function for automatically switching off the FiberXpert OTDR 5000 is available 
only on battery operation, to save the battery

1 In the Utility box, click on Auto off parameter. 
2 Choose a time after which the FiberXpert OTDR 5000 will be switched off 
automatically, if no action has been done for that period: 5, 10 or 30 minutes.

Select No if the FiberXpert OTDR 5000 must not be switched off, even if there is 
inactivity on the equipment.
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Principle of reflectometry measurements

Optical time domain reflectometry consists in injecting a light pulse into one end of 
the optical fiber to be analyzed and observing, at the same end, the optical intensity 
passing through the fiber in the opposite direc- tion to the propagation of the pulse.

The signal detected is exponentially diminishing in form, typical of the phenomenon 
of backscattering, with superimposed peaks due to reflec- tions from the ends of the 
fiber or other variations in the refractive index.

Information yielded by the measurement

From a backscatter trace it is possible, in particular, to determine the position of a 
section of fiber within a link. The measurement result must reveal:
– the attenuation
– the location of faults, by their distance from a point of origin,
– attenuation with respect to distance (dB/km)
– the reflectance of a reflective event or a link.

To locate faults, a reflectometer measures only time. Consequently, group velocity 
must be introduced in order to determine the distance of the location. This is done by 
introducing the refractive index of the fiber into the instrument

5-PRINCIPLE OF MEASUREMENT
This chapter gives the principles of the measurements made by the optical modules.

The topics discussed in this chapter are as follows:

• “Principle of reflectometry measurements”
• “Principle of optical power and attenuation measurements”

Fig. 11 Trace showing typical backscattering
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Validity of Measurement ITU-T

ITU-T in recommendations G.650, G.651 and G.652, give backscatter measurement as 
an alternative method for measuring attenuation, the method of reference being the 
cut fiber.

The field of application of backscatter is not limited, but the conditions for application 
of this method are nevertheless stipulated:
– injection conditions: Fresnel reflections must be limited at fiber input.
– a high-power source (laser) should be used.
– receiver bandwidth should be chosen to achieve a compromise between pulse rise 
time and noise level.
– backscatter power should be represented on a logarithmic scale.

Reflectance

Reflectance is a value with which the coefficient of reflection of a reflecting optical 
element can be quantified. It is defined as the ratio of the power reflected by the 
element over the incident power.

These reflections are due to variations in refractive index all along the optical link in 
certain telecommunications applications. If they are not controlled, they may degrade 
the performance of the system by perturbing the operation of the emitting laser 
(especially DFB lasers) or may generate interference noise in the receiver by multiple 
reflections.

The reflectometer is particularly well suited to the measurement of discrete 
reflectances on an optical fiber link. To calculate the coefficient of reflection, it is 
necessary to measure the total amplitude of the Fresnel reflection generated and 
then to apply a conversion formula to obtain the reflectance value.

This formula takes into account:
– the total amplitude of the reflection measured by the reflectometer.
– the pulse width used to measure the amplitude of the reflection (in nanoseconds)
– the backscatter coefficient of the fiber used:
– typical values of the backscatter coefficient for a pulse of 1 ns and
– for a single-mode fiber:-79 dB at 1310 nm -81 dB at 1550 nm and 1625 nm
– for a multi-mode fiber:-70 dB at 850 nm -75 dB at 1300 nm

NOTE
To measure the widest range of reflection coefficient, it is necessary to insert a 
variable optical attenuator between the reflectometer and the link to be tested. This 
attenuator enables the level of the trace to be adjusted so as to avoid saturation of 
the reflectometer by the reflection to be evaluated.
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PRINCIPLE OF OPTICAL POWER AND ATTENUATION 
MEASUREMENTS
Power measurements

A power meter, is all that is needed to measure emitted or received power:
– to measure emitted power, connect the power meter directly to the output of the 
optical emitter;
– to measure the power at the input of an optical receiver, the power meter is 
connected to the end of the fiber, at the point where the optical receiver would be 
connected.

If the Unit is powered to mains, the battery will charge. The On indicator pass from 
blinking to solid green.

Attenuation measurements (optical link loss)

For measurement of the attenuation of power in a complete link or in elements such 
as sections of fiber, connections or optical components, a light source and a power 
meter are required.

This attenuation is usually deduced from the measurement of optical power at two = 
points:

Attenuation A(dB) = P1 (dBm) - P2 (dBm)

To perform accurate measurements, the following conditions are necessary

– Use a light source which is stable both in time and as a function of temperature.

– Make sure that all connections and fibers and the receiving cell are perfectly clean.

– Use a reference link between the laser source and the test subject.

If several measurements are to be made under identical light injection conditions, this 
reference fiber must not be disconnected during the period while measurements are 
taking place.

Insertion loss method

1 The power meter is first connected to the laser source via the reference fiber: P1 is 
measured.

2 Then the fiber to be tested is inserted between the reference fiber and the power 
meter: P2 is measured.

The difference between P2 and P1 gives the attenuation of the fiber under test.

It is preferable to use the same type of connector at both ends of the fiber being 
tested, to ensure the same connection conditions for measuring P1 and P2.
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Accuracy of measurements

– A high degree of accuracy is often required. It is then necessary to perform a 
preliminary calibration without the fiber under test to eliminate the losses due to 
connections as far as this is possible. To do this, use the «Reference Value» function.
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Optical connector types

There are many optical connectors in the market place. Always ensure to use a high 
quality connector that meets the international standards.

Two main types of connectors are deployed in the telecommunication industry:
1 Straight polished connectors, so called PC or UPC
2 Angled polished connectors, so called APC

6-STARTING UP
This chapter describes how to start using the FiberXpert OTDR 5000. The topics discussed in this chapter are 
as follows:
• “Connecting fiber optic cable”
• “Optical connectors and interchangeable adapters”

CONNECTING FIBER OPTIC CABLE
Inspecting and cleaning connector end faces

Always inspect and clean the connector end face of the optical fiber cable and the test 
port before mating both together. 

Softing IT Networks GmbH is not responsible for damage and reduced performance 
caused by bad fiber handling and cleaning.

– Optical connector contamination is the #1 source of performance degradation and 
test equipment repair

– A single particle mated into the core of a fiber can cause significant back reflection, 
insertion loss and equipment damage. Visual inspection is the only way to determine 
if the fiber connectors are truly clean before mating them.

Follow this simple “INSPECT BEFORE YOU CONNECT” process to ensure fiber end faces 
are clean prior to mating connectors

Fig. 12 “Inspect Before You Connect” process
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Caution
Never connect a PC connector into an APC test port or vice versa. This will result in 
damaging the connector end faces

Warning
Softing IT Networks GmbH declines responsibilities of connector damages if a poor 
quality connector is used or APC to PC connections made. Test port connector repair 
will be charged

Warning
All the universal connectors are available on the OTDR Modules, except on the LA 
Module

Optical connectors and interchangeable adapters

Connecting Fiber optic cable to test port

After ensuring proper cleaning of both end connectors, follow the below steps in 
order to correctly and safely connect the optical fiber into the test port:

1 Carefully align the connector and test port to prevent the fiber end from touching 
the outside of the port and scratching the end face.

NOTE
If your connector features a keying mechanism, ensure that it is cor- rectly fitted into 
the test port’s insert.

2 Push the connector to firmly place it inside ensuring physical end face contact

NOTE
If your connector features a screw-on sleeve, tighten the connector to firmly maintain 
the fiber in place. Do not over tighten as this will damage the fiber and the test port

WARNING
Never force the connector ferrule or insert it with an angle into the test port adapter. 
Mechanical stress may permanently damage the ceramic sleeve of the adapter or 
the end face of the connector. A new adapter purchase only will get the unit back to 
operation

Fig. 13 PC/APC bad connection
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Optical connectors and interchangeable adapters

Fiber Optic modules may come equipped with a universal connector and adapter 
selected at time of order.

Adapter types

Softing IT Networks GmbH offers 4 different adapters, all compatible with this 
connector, allowing the user to switch from one adapter to another according to 
which fiber type he intends to work with.

Adapter types supplied are: FC, SC, DIN, ST and LC.

DIN Adapter (EUDINAD)

ST Adapter (EUSTAD)

FC Adapter (EUFCAD)

LC Adapter (EULCAD)

SC Adapter (EUSCAD)

Switching adapter types

In order to switch from an adapter to another, proceed as shown.

Pull out in the direction of the arrow in order to release the adapter from the lug 
holes

To place an adapter, position the handle as shown in order to engage with the the 
lugs, push hard and pull the handle down

FC Adapter (EUFCAD)

DIN Adapter (EUDINAD) ST Adapter (EUSTAD)

SC Adapter (EUSCAD)

Fig. 14 5 different types of adapters may be mounted on the universal connector

Fig. 15 Removing and refitting an adapter

Pull out in the direction of the
arrow in order to release the
adapter from the lug holes

To place an adapter, position the 
handle as shown in order to engage 
with the the lugs, push hard and pull 
the handle down
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Changing the adapter on a LA OTDR Module

The LA modules are equipped with specific connector and adapters:
1 Unscrew the two screws of the adapter currently mounted onto the connector.
2 Remove the adapter
3 Set the new adapter vertically on the optical connector, making flush the «mark» on 

the adapter with the mark on the connector.

4 Fix the adapter with the two screws.

NOTE
When changing the optical connector, take caution not to scratch the connector 
mating surfaces. Carefully align the removable piece and the baseplate ferrule when 
inserting the adapter part.

Fig. 16 Position of the adapter onto the connector

Fig. 17 Fixing the adapter
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7-ACTIVATING OTDR FUNCTION
Once the OTDR module is correctly set onto the equipment and FiberXpert OTDR 5000 is switched on, the 
desired OTDR function must be selected before any OTDR configuration, or measurement.

The topics discussed in this chapter are as follows:

SELECTING THE OTDR EXPERT FUNCTION
Principle of the OTDR Expert

The OTDR Expert is used to

– perform OTDR acquisitions with full OTDR setup capabilities, and advanced analysis 
features.

– create configuration files that can be loaded by Smart Test users.

Selecting OTDR Expert

To select this function, after the equipment start:
1 Press the HOME button
2 Select the OTDR Expert icon 

The icon turns yellow. 

After a few seconds, the Results page displays.

NOTE
In the case a Singlemode/Multimode module, one line contains the Multimode icons 
and a second one the Singlemode icons. To distinguish both modes, multimode icons 
contain the MM mark.
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8-CONFIGURING THE TEST IN EXPERT OTDR
Once the Expert OTDR icon is selected, the Results page automatically displays.

In Expert OTDR, the parameters for acquisition and for file storage can be configured.

1 To call up the test configuration window, press the SETUP button. Dialog boxes and menu keys on the 
same screen enable selection of

Configuring the Acquisition parameters

You can choose the OTDR acquisition parameters. 

1 Once the Setup page is displayed, press Acquisition menu key to configure the 
Acquisition parameters.

The Acquisition Setup page is divided into two parts: the Acquisition box and the 
Launch cable box.

Parameters Laser

The acquisition will be carried out on the wavelength(s) selected (for multiple 
wavelength modules). In case of a multi-wavelength module, select All to perform a 
measurement for all the wavelengths available (this parameter visible exclusively on 
modules with one single OTDR port). The possible values depend on the module used.

– Acquisition parameters
– Alarms parameters
– Analysis parameters

Used for the OTDR acquisition

– Link parameters
– File parameters Used for OTDR result saving

Fig. 18 OTDR setup in Expert OTDR mode In these windows, the parameter selected is in video inverse
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Acquisition

Select the kind of acquisition to be performed:

Manual The acquisition parameters Pulse / Range / Resolu- tion can be set by user.

Auto

Auto The acquisition parameters Pulse / Range / Resolu- tion are defined 
automatically and cannot be modi- fied

The Measurement time will be set to Auto, but can be modified (see “Time” page 24).

Range

The possible range depends on the pulse length selected. This range is given for each 
pulse length in the paragraph. This parameter is exclusively configurable if Acquisition 
parameter is set to Manual. It depends on the module used.

Auto allows to detect automatically the range. The range is selected as a function of the end 
of the fiber.

Pulse

From 3ns to 20μs according to module used. Parameter selectable only if Acquisition 
parameter is set to Manual.

NOTE
According to the value selected for Pulse parameter, the Range parameter can be 
automatically modified, and vice-versa.

Resolution

This parameter is exclusively configurable if Acquisition parameter is set to Manual.

Auto resolution is selected automatically according to the last two parameters above.

High Resolution the highest resolution is applied

High Dynamic the highest dynamic is applied

Time

Real time the equipment performs up to ten acquisitions per second.

NOTE
Whatever is the acquisition mode selected, an acquisition in real time mode can be 
launched aintaining the START/STOP button pushed for about 2 seconds.

NOTE
If the Acquisition parameter is defined to Auto, then the Time parameter is defined to 
Auto, but can be modified.

Manual Enter the acquisition time desired (from 5 s. to 5 minutes max).
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Predefined Select one of the acquisition times predefined: 10 seconds / 20 seconds / 30 seconds / 
1minute / 2 minutes / 3 minutes.

Configuring the Alarms parameters

In the Setup page, press Alarms softkey (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Alarms).

Once the Alarms page is displayed, configure the parameters for applying thresholds 
to results displayed.

Threshold

None The alarm function is not active

User Thresholds can be defined for: Splice Loss / Connector Loss / Reflectance / Splitter 
Alarm / Slope / Fiber Length Min and Max / Link Loss Min and Max / ORL

TIA-568 C / ISO/IEC 11801 / Default / G.697/G.98x PON / G.697/ IEEE PON
Select one of this parameter to configure the alarm thresholds with predefined values:

Table 1 Singlemode Modules

SOFTING IT NETWORKS G.697/G.98x PON G.697/IEEE PON

Default TIA-568C ISO/IEC 11801

Splice Loss > 0.20 dB > 0.30 dB > 0.30 dB

Connector Loss > 0.50 dB > 0.50 dB > 0.75 dB

Slopea > 1.00 dB/km - >1.00 dB/km

Reflectance > 35 dB >35 dB

ORL < 27 dB

Splitter Alarm 1 X 2 > 5.0 dB > 4.2 dB

1 X 4 > 8.0 dB > 7.8 dB

1 X 8 > 11.0 dB > 11.4 dB

1 X 16 > 14.0 dB > 15.0 dB

1 X 32 > 17.0 dB > 18.6 dB

1 X 64 > 21.0 dB > 22.0 dB

Link Loss Max Select: No/ Manual or:

– for G.697/G.98x PON: 20 dB (A) / 25 dB (B) / 30 dB (C)

– for G.697/IEEE PON: 30 dB (C) / 23 dB (PX-10) / 26 dB (PX-20)

a. This parameter is not available in OEO-OTDR configuration
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Configuring the Analysis parameters

In the Setup page, press Analysis softkey (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Analysis).

The Analysis Setup page is divided into two parts: the Parameters box and the 
Measurement box.

Parameters Parameters Section Attenuation

dB/km Displays the section slope in the table of results. When the fiber is too short to 
measure the slope accurately, no value is displayed (empty field).

dB
Displays the section Loss in the table of results. With short fiber where the slope 
cannot be measured with a good accuracy, the loss in dB is approximate and 
displayed.

None The section attenuation and Loss values are not displayed in the table of results.

Index of refraction

Choice of group refraction index of the whole fiber.

User

Define for each wavelength (1310 SM, 1360-1510 SM, 1550 SM, 1625 SM) a refraction 
index of 1.30000 to 1.69999. The selection of an index alters the value of the section 
AB (actual distance between cursors A and B). or, If the actual distance between the 
cursors A and B is known, enter its value under Section AB to establish the index of 
the fiber. Selection of this distance causes the display of the indices.
The extreme distance values are given by the index values (1.30000 à 1.70000).

Default                                                TIA-568C ISO/IEC 11801

Splice Loss > 0.20 dB > 0.30 dB

Connector Loss > 0.50 dB > 0.75 dB

Slope 850 nm > 3.50 dB/km > 3.50 dB/km

Slope 1300 nm > 1.50 dB/km > 1.50 dB/km

Reflectance  - > - 35 dB -

ORL < 27 dB -

If results are above those thresholds, they are highlighted in red in the table of results, and the   icon 
appears at the top right of the screen

If all the results lie within the thresholds (no result is in red or yellow), they are displayed in green in the 
table and the icon  is displayed at the right top of the trace.

Table 2 Multimode Modules
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Predefined It is possible to choose one of the predefined values given for certain cables.
The corresponding indices given in the table below are repeated on the screen.

Wavelength (nm) 1310 SM 1360 - 1510 SM 1550 SM 1625 - 1650 SM

Generic G652 G657 1.46750 1.46800 1.46800 1.46850

Generic G653 G655 1.46750 1.46800 1.46800 1.46850

ATT SM 1.46600 1.46700 1.46700 1.46700

Corning SMF-28 1.46750 1.46810 1.46810 1.46810

Corning SMF-DS 1.47180 1.47110 1.47110 1.47110

Corning SMF-LS 1.47100 1.47000 1.47000 1.47000

Corning-Leaf 1.46890 1.46840 1.46840 1.46900

Draka SMF 1.46750 1.46800 1.46800 1.46850

Draka Longline 1.46700 1.46700 1.46710 1.46750

Draka Teralight 1.46820 1.46820 1.46830 1.46850

Draka Benbright 1.46750 1.46750 1.46800 1.46850

Fitel Furukawa 1.47000 1.47000 1.47000 1.47000

OFS Lucent Allwave 1.46750 1.46750 1.46750 1.46850

Lucent Truewave 1.47100 1.47100 1.47000 1.47000

SpecTran SM 1.46750 1.46810 1.46810 1.46810

Sterlite 1.46700 1.46700 1.46750 1.46750

Sumitomo Litespec 1.46600 1.46600 1.46700 1.47000

Sumitomo Pure 1.46600 1.46600 1.46700 1.47000

Wavelength (nm) 850 MM 1300 MM

Corning 62.5 1.50140 1.49660

Corning 50 1.48970 1.48560

SpecTran 62.5 1.49600 1.49100

Generic 50 1.49000 1.48600

Generic 62.5 1.49000 1.48700

Generic OM1-62/125 1.49600 1.49100

Generic OM2-3- 4 50/125 1.48200 1.47700

Fig. 16 Predefined index values (Single Mode)
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Scatter coefficient

User Selects for each wavelength, the backscatter coeffi- cient of -99 dB to -50 dB by 
increments of
0.1dB. Modification of the backscatter coefficient K changes the measurements of 
reflectance
and ORL.
Backscatter coefficients are selected automatically for each wavelength.

Auto In Multimode, two predefined scatter coefficients are available:

Generic 50 850 MM - > -66.3 dB 1300 MM -> -73.7 dB

Generic 62.5 850 MM -> -66.1 dB 1300 MM -> -70.3 dB

The default values are given in the paragraph

Distance Unit

Define the unit of the distances displayed: km, kfeet, miles, meter, feet.

Results on trace

None the trace alone

All the trace with results and markers.

Graphics the trace with markers only.

If All or Graphics is selected, the reflectometry trace is displayed with a dotted vertical 
line set on the end of launch cable  (if the Launch Cable is defined in the SETUP 
menu) and a dotted vertical line on the end of fiber. 

Measurement Otdr Connector Measurement

This parameter allows to choose if a measurement of the front connector must be 
performed when acquisition is launched

Cable start

No In the results table, the first line corresponds to the first event detected.

Yes In the results, the first result corresponds to the front connector measurement, at 0 
meter (estimated value).

Number of Splitters (not available in Multimode)

Once parameter is selected, press Edit Number key to display the numeric keypad and 
select the wished value:

None there is no splitter set onto the network.

Discover Auto-detection and identification of PON splitter types.

1 to 3 If the number of splitters if known, select it from the list (from 1 splitter to 3 splitters).

This selection opens a sub menu into which the splitters types must be defined for all 
splitters installed.

Fig. 17 Predefined index values (Multi Mode)
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Splitters types

Splitter 1: define the splitter type among the list:
– 1x2 / 1x4 / 1x8 / 1x16 / 1x32 / 1x64 
– 2x2 / 2x4 / 2x8 / 2x16 / 2x32 / 2x64

Splitter 2 and Splitter 3: define the splitter type among the list:
– 1x2 / 1x4 / 1x8 / 1x16 / 1x32 / 1x64

Detection

Splice Select if a level of detection for splice must be defined.
Press Edit Number soft key and select a value:
– Enter a min level of detection, from 0.01 to 1.99 dB
– No: no splice detection
– Auto: to automatically detect splice

Reflectance Select if level of detection for reflectance must be defined.
Press Edit Number soft key and select a value:
– Enter a min level of detection, from -98 to -11 dB
– None: no reflectance detection
– All: all reflectances are detected

Ghosts Choice (Yes / No / No Analysis) of whether informa- tion relating to ghosts is to be 
displayed. If ghosts are displayed, the reflection icon in the table of results appears 
dotted and the reflection value is displayed in brackets on the trace, for example «(R:-
50 dB)».

Fiber end Once parameter is selected, press Edit Number key to display the numeric keypad and 
select the wished value:
– Auto (recommended): option in which the iberXpert OTDR 5000 automatically 
detects the end of a fiber.
– > 3 to > 20 dB(steps of 1 dB): threshold of detection of end of fiber.

Bend (not available in Multimode) With any dual or triple- wavelength measurement 
module, the user will have access to the macro bend detection function in the test 
setup. Each event of the selected wavelengths will then be compared.
Once parameter is selected, press Edit Number key to display the numeric keypad and 
select the wished value:
– None: Bend will not be detected.
– Auto: Bend will be automatically detected.
– Define by user: Enter the bend value (in dB), with direction keys or numeric keypad.
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Configuring the Link parameters

In the Setup page, press Link softkey (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Link).

NOTE
The softkey Copy File/Link to all is displayed when one parameter is selected in the 
Link or File Setup page and when the Powermeter or Source function is active.

It allows to apply the Link and File configuration parameters of the current 
applications to all the other active Fiber Optic applications (powermeter, and source).

The information entered in the Link Description window concerns the editing and/or 
the modifications of the cable and fiber parameters. When a trace is recalled without 
recall of the configuration, the parameters of this trace will be present only in its 
signature.

Fiber ID

Select the parameter Fiber Id and enter a name for the fiber, using the edition keypad.

Fiber Number / Fiber Code

The parameter Fiber Number becomes Fiber Code if, in the Cable Structure window, 
the Cable Content parameter is defined on another parameter than Fiber (Ribbon/
Fiber, Tube/ Fiber or Tube/Ribbon/ Fiber).

The fiber code corresponds to the fiber number if, in the Cable Structure, the 
parameter Color coding is defined on No.

The fiber code corresponds to the fiber color if, in the Cable Structure, the parameter 
Color coding is defined on Yes.

1 Select the parameter Fiber Number/Fiber Code and modify the parameter using the 
left and right direction keys.

The fiber number can be automatically incremented/decremented at each new file 
save if it has been configured in the File Setup page

NOTE
The Fiber Code and the fiber number concatenated with Fiber Name are 
interdependent: they are incremented or decremented at the same time. However, 
the fiber number remains a number only, while the fiber code is alphanumerical. 
Whether it includes a color code or not it may be composed of one, two or three 
parts.

Fiber and cable parameters used in the example:

Fiber Name: ’Fiberx’
Cable Content: ’Tube/Fiber’ Max Tube: 12
Max Fiber: 24
Coding used for the fiber and the tube: TIA
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Fiber N Fiber N+1

ColorCode Yes No Yes No

<Fiber Name> Fiberx24 Fiberx24 Fiberx25 Fiberx25

<Fiber Code> Bl/Aq- 1/24 Gold/Bl 2/1

Fig. 18 Example of incrementation of fiber code

Change Fiber Nbr

Increment the fiber number is automatically incremented at each new file-save.

Decrement the fiber number is automatically decremented at each new file-save

User defined Use Edit Number softkey to enter the increment / decrement value for fiber number.

NOTE
to decrement the number, enter the sign «-» before the number. Example: -1. Min: 
-999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified.

Cable Id

This parameter allows to enter an identification of the cable, using the Edition menu.

Direction

The direction shows if the acquisition has been made from the origin to the extremity 
(A- >B) or from the extremity to the origin (B->A). Changing direction makes it 
possible, when different extremities are handled, to see the parameters of the fiber 
for the other extremity.

Location A

The name of the Location A of the link may be entered here.

Location B

The name of the Location B of the link may be entered here.

Operator

Use the arrow to enter the name of the operator carrying out the measurement.

Job Id

Use the arrow to enter a description of the measurement to be performed.
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Comment

In contrast to the other data in this menu, the comment is specific to a fiber. This line 
is thus used to enter a new comment and not to display it. The comment appears 
at the top of the screen, with the other parameters of the fiber. This comment will 
remain available for the next acquisition, unless it is deleted. It is also saved when a 
trace is saved with a comment.

Configuring the file storage parameters

The File storage parameters must be also configured, in order to define how the 
results traces will be saved onto the FiberXpert OTDR 5000.

In the Setup page, press File softkey (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on File).

NOTE
The softkey Copy File/Link to All is displayed when one parameter is selected in the 
Link or File Setup page and when the Powermeter or Source function is active.
It allows to apply the Link and File configuration parameters of the current 
applications to all the other active Fiber Optic applications (powermeter, and source).

Dir

This parameter cannot be configured, and display the directory selected by default 
intowhich the file(s) will be saved (the last directory selected).

To modify the directory, go to the Explorer page and select another directory.

This parameter allows to enter an identification of the cable, using the Edition menu.

Filenaming

Select Filenaming parameter and press the right arrow key to modify the name of the 
file forthe result trace.

In the edition keypad, enter a name manually for the file and/or use the predefined 
parameters available (Cable_Id, Fiber_Num...). Then, press Enter to validate.

Predefined parameters for naming files

Predefined
parameters for
naming files

Fig. 19 Filenaming - Edition keypad
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or, Press Default Filename to apply the name by default to the file:

Fiber[Cable_Id][Fiber_Num]_[Lambda]_[Direc- tion][Pulse]

The name of the file is displayed in grey under Filenaming parameter

File Content

In this parameter, select the file content for traces saving

One Trace in case of traces in overlay, each trace is saved in a distinct file (.sor extension).

All Traces in case of traces in overlay, all traces are saved in one single file (.msor extension).

Save Mode

When a trace or more is displayed, in the parameter Save Mode, you can select three 
types of methods for storing traces:

File Only only the trace(s) is/are stored in one/several file(s), with its extension (.sor, .msor)

File + txt the trace(s) is/are stored in one/several file(s), with its extension and one txt file is 
also generated.

File + pdf the trace(s) is/are stored in one/several file(s), with its extension and one pdf file is 
also generated.

All the trace(s) is/are stored in one/several file(s), with its extension and one pdf file + 
one txt file are also generated.

Auto Store

Select Yes to store automatically the trace or traces resulting from each acquisition 
according to the filenaming rules.

Configuration in Test Auto mode

The Test Auto key imposes the parameters for acquisition, measure- ment and display 
of results defined as default settings in factory.

ACQUISITION Acquisition Laser All
Acquisition Auto
Time Auto
Smart Acq No
OTDR Connector Test Yes & Cont
Launch Cable End No
Launch Cable Start No

Launch Cable
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Reflectance All Ghost No Fiber End Auto Bend Auto
LINK Link Description Change Fiber Nr Increment
FILE File configuration Filenaming Auto filenaming

ALARMS Alarms Thresholds None
ANALYSIS Parameters Section Attenuation dB/km

Index of Refraction G652 G657
Scatter Coefficient Auto
Results on trace Graphics
OTDR Connector Meas. No
Number of Splitters Splice None

Auto
Measurement

Saving OTDR configuration in a file

Once File and Measurement parameters have been configured, those parameters can 
be kept in memory and saved in a configuration file.

This configuration file can then be recalled in two cases:
– in order to be applied when acquisition in Smart Test mode is performed.
– in order to be recalled for future acquisition in Expert OTDR To save parameters in a 
configuration file:

1 If necessary, press SETUP to return to Setup page.

2 Select one parameter in one of the setup page (acquisition, link..)

3 Press menu key. An edition keypad displays

4 Enter a name for the configuration file (max. 20 characters).

NOTE
Configuration file is saved by default in the directory disk/config.
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5 Press Enter to validate. A sound is emitted to indicate the file is saved.
The configuration file is saved with the extension .fo_cfg (icon ) and can be recalled at 
any time from the Explorer page.

This configuration file can be selected in Smart Test or loaded for Expert OTDR.

Loading an existing OTDR configuration

To load a configuration file previously created or available in the FiberXpert OTDR 
5000 and apply parameters to new OTDR Expert tests:

Saving OTDR configuration in a file

1 Press FILE hard key

2 Select the configuration file desired

3 Press Load > Load Config.

– Press SETUP hard key to display the OTDR acquisition parameters saved in the 
selected configuration file.

You can modify some acquisition or file storage parameters, and save them in a new 
configuration file

Directory into
which file will
be saved

Fig. 20 Save Configuration file - Edition keypad
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From the Setup page

1 Select one header in either Setup page (Acquisition, Link, File...)

2 Press Load Config. menu key. The file Explorer page displays

3 Select the configuration file desired

4 Press Load Config. to load the configuration file for acquisition in OTDR Expert 
mode.

A sound is emitted to confirm the loading. The Setup screen is displayed again.

NOTE
Most of the configuration files are available into the equipment, in disk/config.

The main parameters available in the selected configuration file are displayed in the 
File signature.

Configuration file will be used for Expert OTDR acqui- sition only

Configuration file will be used for Expert OTDR Test acquisitions

The main parameters available in the selected 
configuration file are displayed in the File signature.

Configuration
file will be used
for Expert OTDR
acqui- sition only

Configuration file
will be used for
Expert OTDR Test
acquisitions

Fig. 21 Loading a configuration file
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LAUNCHING A REFLECTOMETRY TEST
AND DISPLAYING RESULTS
Once the configuration for acquisition and file storage has been defined, the instrument is ready to launch 
an OTDR measurement.

Pressing the START/STOP key is all that is needed to start or stop an OTDR measurement on the FiberXpert 
OTDR 5000.

This chapter describes the different stages in a reflectometry measure- ment. It then describes the functions 
available on trace(s).

The topics discussed in this chapter are as follows:

• “Performing OTDR acquisitions”
• “Results display”
• “Advanced functions
• “Saving the trace(s) and generating a report”

Performing OTDR acquisitions

Performing an acquisition in Real Time mode

Principle of the Real time mode

Acquisition in real time must not be used if a precise measurement is required 
because of the high noise level, but it is sufficient for rapid opti- mization of a 
connection and for observing a fiber in process of utilization.

Performing acquisition in Real Time

To carry out an acquisition in real time:

1 Hold the START/STOP key down for about three seconds, to launch the acquisition in 
real time.
or
If the Time parameter is defined with Real Time in Setup page, press START/STOP 
hard key. The red Testing indicator will go on to show that real time acquisi- tion is in 
progress. The trace acquired is displayed in real time.
An indicator of the state of the connection (Good/Bad) is displayed below the trace:

State Connection

Good The connection is OK

Bad – There are several connectors close to the external connector of the FiberXpert.

Table 3 Connection indicator
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– One of the connectors is dirty or badly connected. Replace the launch cable, make 
the connection again properly or clean the connector of the OTDR or of the jumper.

– No fiber is connected.

If the state of the connection is bad, it is still possible to carry out a measurement, but 
the results will not be very reliable.

Traffic detection

Copy/Cut & Paste files/ directories

Traffic on the fiber under test is automatically detected and reported.

Press the START/STOP key to begin the measurement. A message indi- cates there is 
traffic on the fiber and asks you if you wish to continue or not:

– If you click on NO, the measurement is not launched.

– If you click on YES, the measurement is performed, despite the traffic.

NOTE If the measurement is validated despite the traffic (key YES), the next 
measurement will be automatically performed, even if traffic is still detected on fiber.

If the measurement is cancelled (key NO), and the START/STOP pushed another time, 
the box asking if you wish to continue or not is displayed.

The functioning of Traffic Detection is then indicated in the scaled down 
representation of trace, on the upper left part  of screen. During an acquisition 
in real time, several actions can be made on results in progress: see

Performing an acquisition with Expert OTDR

In this mode, the equipment carries out a number of averagings defined as a function 
of the maximum acquisition time specified in the Acquisition menu, and then 
terminates the acquisition.

Fig. 22 Example of acquisition in Real Time
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The acquisition is carried out with the parameters previously selected in the 
Acquisition menu. It may be stopped at any time using the START/ STOP key.

1 Press the START/STOP key to start the acquisition.
The red indicator goes on to show that the product is in process of acquisition and the 
screen displays the trace in process of acquisition.

2 The quality of the connection is displayed for a few seconds

3 Then, a bar graph shows elapsed and remaining acquisition time.

At the end of the acquisition, a beep is emitted, the trace is displayed and an 
automatic measurement is started.

NOTE
During acquisition, the traffic on fiber is automatically detected

NOTE
To stop the acquisition, the START/STOP key may be pressed at any time. Then an 
automatic measurement is carried out, but some events cannot be detected (a 
manual measurement must then be made).

Performing an acquisition from Results page

Once the results page is displayed, you can perform a new acquisition modifying the 
main acquisition parameters.

Elapsed
acquisition
time

Number of
averages
calculated

Elapsed
time

Total
acquisition
time

Fig. 23 Acquisition in progress with FiberXpert OTDR
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Before launching a new OTDR acquisition, make sure the trace(s) displayed have been 
previously saved if necessary, as the new acquisition will automatically delete the 
displayed results.

1 On Results page: in Expert OTDR mode, press the softkey Quick Setup: the 
acquisition parameters that can be modified display under the results trace. In Smart 
Test mode, pres the softkey Setup: the Setup screen displays

2 Modify the acquisition parameters wished in the displayed menu:

– In Expert OTDR mode: Laser / Acquisition / Range / Pulse / Time. – In Smart Test 
mode: Laser / Fiber Number / Distance unit

3 Once configured, launch the new OTDR test pressing the START/ STOP hard key.

Press again (Quick) Setup menu key to hide the menu under the trace.

Multi- wavelength acquisition

If the module possesses several lasers, to perform successive acquisi- tions on all the 
wavelengths:

1 In the SETUP menu, check in Laser line, that several lasers are selected (or select All 
if a module with only one OTDR port is used).

2 Start the acquisition by pressing the START/STOP button.

3 Once the acquisition for the first wavelength is finished, the acquisi- tion for the 
following wavelength starts automatically.

or
To stop manually the acquisition for current wavelength, click on Stop Wavelength. 
This will allow to automatically start the measurement for the following wavelength.

The different traces appear in the same window and can be handled simi- larly to 
overlaid traces.

Fig. 24 Results page and Quick Setup menu (Expert OTDR)
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Actions on trace during acquisition

During an acquisition, several actions are available on results in progress.

Actions on trace during acquisition

1 Select Cursor A or Cursor B and:

– Set both cursors A & B to control distance between two points.
– Set one cursor A or B to get the distance from one point.
– Set one cursor A or B to zoom on this cursor

Zooming on trace

1 Select Zoom function:
– use the menu key in Expert OTDR

2 Use touchscreen or validation key to zoom in and zoom out on trace

Shifting the trace

In Expert OTDR mode only, the trace can be shifted vertically or horizon- tally during 
the acquisition:

1 Select Shift function on menu key

2 Use touchscreen or direction keys to shift horizontally or vertically the trace

Displaying Trace or Summary page

1 Use the menu key Trace/Summary to display either: – the acquisition trace in 
progress and the bar graph of time – the Summary page with exclusively the bar graph 
of time.

In the case of measurement on several wavelengths, once a measure- ment is 
completed for one wavelength:

– the Trace function allows to display the trace and results table for this wavelength: 
once Trace is selected, press validation key ( or ENTER) to pass from Trace + results 
table on 1 line to Trace + results table on 4 lines, and vice-versa,

– the Summary function allows to display a summary of results for this wavelength.

Modifying acquisition parameters (in Real Time mode only)

You can modify the acquisition parameters without returning to the SETUP menu.

1 Press the Acquisition Param key

2 Use displayed keys to scroll through the possible values of the various acquisition 
parameters.
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Zooming on the fiber end (in Real Time mode only)

During a real time acquisition, you can reach the end of the fiber under test at any 
time:

1 Press Zoom to End menu key.

The display automatically reaches the end of the fiber under test.

The menu key Zoom to End becomes Zoom to Start.

Press Zoom to Start to display the start of the fiber under test.

Performing measurements during acquisition (Real Time mode only)

The real time mode allows to make Loss, ORL or Reflectance measure- ment using the 
A & B cursors and the key Loss / ORL / Reflect.:

1 Position A & B cursors on the trace

2 Click as many times as necessary on key  to get the measurement between A 
& B cursors.

Fig. 25 Example of acquisition in Real Time

Fig. 26 Example of loss measurement
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Results display

The traces acquired or recalled from a memory are displayed on the Results page. 
According to the mode of acquisition (Expert OTDR or Smart Test), the results page 
offers similar functions, but also different functions.

T– On the upper right side, the alarm icon is displayed (if some alarm thresholds are 
defined in the pre loaded configuration file).

Table 4 Alarms display

Fail Indicates that at least one result exceeds the alarm thresh- olds defined in the 
configuration file used for acquisition Results are displayed in red in table.

Valid 
Indicates that all the results lie within the thresholds (no result is in red or yellow).
Results are displayed in green in the table.

Common functions

Display of events on the trace

Each event detected is referenced under the trace by a serial number. The 
reflectometry trace is displayed with a dotted vertical line set on the start of launch 
cable (if the Launch Cable End parameter is defined in the SETUP menu)

Fig. 27 Example of results trace with Smart Test

Fig. 28 Example of results trace with Expert OTDR
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The trace can also be displayed with a dotted vertical line on the end of fiber. 

The icon  is displayed on trace if the Receive Cable Start parameter has been 
defined in the Setup menu.

The results of the measurements of attenuation, reflectance and slope can be marked 
on the trace.

The reflectance of a ghost event is displayed in brackets on the trace.

Criteria for display of an event

An event will be displayed if its attenuation or its reflectance exceeds the 
corresponding threshold selected in the SETUP menu..Attenuation and reflectance 
results for an event will be displayed if they can be calculated

The reflectance of an event is always measured except when the event causes a 
saturated Fresnel peak or if it is drowned out by noise. In this case, the FiberXpert 
OTDR 5000 displays > to show that the actual reflectance exceeds the value displayed.

Results table

Under the trace is displayed the results table with all the events detected during 
acquisition.

– In Smart Test: if the Total Loss and End of fiber values are displayed under the trace

– click on the trace overview (upper left part of the screen) to display the 4-lines 
results table

or

– select Trace on Trace/Summary softkey and press validation key ( or ENTER) to 
display the 4-lines results table

Repeat one of this method to come back to Total Loss and End of fiber values.

Fig. 29 Trace + Table results in Smart Test
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– In ExpertOTDR mode, once Trace is selected, press validation key ( or ENTER) to pass 
from Trace + results table on 1 line to Trace + results table on 4 lines, and vice-versa

The table with one line displayed under the trace gives the type and characteristics of 
the event nearest to the cursor.

The 4 lines table gives the type and the characteristics of all the events detected 
during the measurement: the 4 first lines displayed correspond to the 4 first events 
nearest to the cursor. The line corre- sponding to the event nearest to the cursor is 
highlighted. This highlighting moves if the cursor is moved.

At the top of the table, a line shows the generic parameters of the fiber: numbers of 
events present, total ORL of the link and, in ExpertOTDR mode, reference trace icon

Each event is referenced under the trace by a number which is repeated in the first 
column of the table. The table then shows:

– icon symbolizing the type of the event:

Receive cable Start Launch cable End: the attenuation and distances are measured on 
the basis of the

corresponding marker.

Non-reflective attenuation (e.g. splice).  Splitter.

Reflective event. (e.g. connector)

Ghost reflection

Slope of the fiber (when no fault follows the slope).

End of fiber

OTDR connector Merged Connectors Loss

– Total group loss = loss on last connector – Loss connector N-1 = 0 dB)

Event marker when a measurement cannot be carried out. If the event to be added 
is too close to an existing event, the icon appears on the trace and the table, but 
no measurement is carried out: to obtain the results for this event, a manual 
measurement is necessary.

Fig. 30 Example of trace and results table in Expert OTDR
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The event underlined in yellow is the one the nearest of the cursor set on trace. To 
visualize an event, click on this event on the table to set the cursor on it onto the 
trace.

Detailed description of an event

Click on one event icon in the results table to display the event type and the alarm 
threshold defined for this event (if Alarms have been defined in the Setup page).

If the value of the event selected exceeds the defined threshold, then the possible 
causes for this alarm are described in the window:

The following columns are then displayed next to each event icon:

Distance The distance of the event from the beginning of the fiber, in meters (or miles)

Loss The attenuation due to the event, in dB

Reflect. The reflectance of the event, in dB

Slope (Expert
OTDR only) The slope before the event, in dB/km (or dB/kft) if it can be measured

Section
(Expert OTDR
only)

The length of the section = the distance between the marker of the event and the 
previous marker.

T. Loss The total attenuation of the fiber (total loss), in dB

Cursors

The cursors A and B are represented by vertical lines of different colors:

– in a solid line if the cursor is selected.

– in a dotted line if the cursor is not selected.

Fig. 31 Event description
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Positioning the cursor

1 Press the key  to active the cursor.

2 Touch the screen on the required location on trace where the active cursor must be 
set.

You can also use the direction keys  and  to move the selected cursor along the 
trace

Above the trace is shown the 2-points loss measurement between the two cursors, 
together with the distance between the two cursors.

The cursors data are displayed exclusively if the Cursor menu key is active. If another 
key is active, the display shows help tooltips, different according to the selected 
function.

When the cursor function is selected, the keys  and  move the trace vertically.

Cursors information

The information related to cursors are displayed exclusively when the Cursor function 
is selected (menu key  selected).

Above the trace are shown the co-ordinates of the points of intersection of the 
cursors A and B with the trace, together with the distance between the two points.

Cursor function not selected

When Cursor menu key is not selected, the upper banner displays information, 
different according to the menu key selected:

– If the Trace/Summary key is selected, with Trace function valid, the upper banner 
indicates that to change the displayed trace, you can click on the banner or on the 
right arrow key

The Cursor function is 
not selected

The Cursor function is
selected

Fig. 32 Cursors information
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– If the Zoom/Shift key is selected, and the Zoom function valid, the upper banner 
indicates that to get an automatic or full zoom, you must press validation key
(or ENTER).

Zoom function

The Zoom function is used to analyze part of the trace in greater detail.

The zoom is centered on the active cursor.

The position of the section of trace displayed with respect to the complete trace is 
represented by a red rectangle on the mini-trace at the top left- hand corner of the 
screen.

Defining a zoom on the trace using the touchscreen or screen deported on PC

1 Press Zoom or Zoom/Shift softkey to activate the zoom function
– menu key in Expert OTDR

2 Press once in one location on the screen, which will represent the upper left corner 
of the zoomed area.
The icon  is displayed on the screen

3 Press another time on the location which will represent the lower right corner of 
the zoom.

Defining a zoom level on the trace using direction keys

1 Select Cursor A or B and center it on the zone to be examined

2 Press Zoomsoftkey.

3 Use the  or  key to increase or reduce the zoom factor, keeping the selected 
cursor centered on screen.

Defining a zoom on the trace using the touchscreen or screen deported on PC

Swapping from an automatic zoom to full trace and vice-versa

The automatic zoom allows to get an optimized display of the trace. To apply an 
automatic or entire zoom on the trace:

1 Press Zoomsoftkey.

2 Press validation key  or ENTER) to apply an auto zoom on trace.

Press again validation key (  or ENTER) to display the trace in full screen.

Fig. 33 Zoom on trace using touchscreen
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Specific functions of the zoom with a touchscreen

With the touchscreen, once the Zoom function is selected on menu key Zoom, you 
can:

– maintain your finger pressed on screen and shift the traces horizontally or vertically

– position your finger on a cursor and move it on trace maintaining your finger 
pressed and moving it toward left or right

– once a zoom is performed, double click on the zoomed zone to undo the zoom

Zooming on the different events in succession

1 Set the cursor on one event

2 Define a zoom on this event.

3 Click on another event in the results table

The cursor is automatically positioned on this event, which is always centered on the 
screen, keeping the zoom level selected.

– select Trace on Trace/Summary softkey and press validation key ( or ENTER) to 
display the 4-lines results table

Repeat one of this method to come back to Total Loss and End of fiber values.

Shift function

The Shift function is used to displace the displayed section of the trace by pressing the 
direction keys or directly clicking on the touchscreen.

The horizontal shift is performed maintaining the point of intersection between the 
trace and the selected cursor at the same level, scrolling the trace horizontally while 
following it vertically, so that it never goes off the screen.

To use this function:

1 Select the zoom factor as described above.

2 Choose cursor A and cursor B position.

3 On the Zoom/Shift key, select Shift.

4 Displace trace manually on touchscreen toward left/right or upward/ backward. or

Use the direction keys to shift the trace in the desired directio 

Summary

To display a summary of the results, select Summary function on Trace/ Summary 
menu key.

The upper table displays a summary of results for each wavelength onto which 
measurement has been performed.

Some results can be displayed in color (green or red) if they lie within or exceed the 
alarm thresholds defined in the Setup screen in ExpertOTDR mode and defined in the 
configuration file used for acquisition in Smart Test mode.
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In the lower part of the screen, the Alarms table, gives the summary of the alarms 
detected (Reflectances, Splices, Splitters, Connectors, Bends...).

Select one event in the Alarm table and click on Event Diagnosis menu key or directly 
on the event icon in the Alarm table to get a detailed description of the event.

Click on Trace View softkey to return to display of Trace + Results Table.

Display of traces in overlay

– The traces are shown in different colors (the active trace is green).

– The mains acquisition parameters are displayed at the top of the screen.

Fig. 34 Summary page & Alarms table

Abb. 35 Summary key - Event Diagnosis

Fig. 36 Traces in overlay
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Selecting one trace from overlaid traces

To make actions on a trace in overlay (move on events, set a cursor...), it must first be 
swapped with the active trace. To do this:

1 Press the Trace key

2 Press the direction keys and , as many times as necessary, until the active trace is 
displayed in green. traces numbers

or

Click on the trace numbers in the upper right side of the result page until the trace 
desired is selected.

or

Click on the upper part of the screen, in Trace information zone to scroll the traces.

NOTE
Actions relative to traces (move cursors, move on events...) are exclusively done on 
the active trace (in green), not on the other ones.

Traces display in double acquisition mode

When a double acquisition has been performed, i.e. a short acquisition preceding a 
standard one, two traces are displayed in the same window.

The short trace is the one resulting from the short acquisition and stops while the 
standard

Advanced functions

Automatic measurement and detection

If the instrument does not detect all the expected events, additional manual 
measurements can be carried out.

To delete all the markers:

Standard acquisition
(in green)

Short acquisition
(in blue)

Fig. 37 Traces display in double acquisition mode
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1 Press the Advanced key

2 Press the Modify meas.key,

3 Select Delete.

4 Press validation key (  or ENTER)

The following procedure is then recommended:

1 By default, the instrument locates the events and proceeds to the measurements.

2 Addition of events in the cases of splices showing low attenuation and of close 
events. The FiberXpert OTDR 5000 then automatically measures the slope before and 
after the markers selected and measures the attenuation of the splice.

3 Addition of manual measurements if necessary (for deeper analysis). 
The FiberXpert OTDR 5000 performs the measurements requested by the user.

To start an automatic measurement while a measurement is already in progress:

1 Press the Advanced key.

2 Press the Modify meas.key

3 Select Delete and press validation key (  or ENTER).

4 Select Auto Meas. and press validation key (  or ENTER).

Addition of events

You can also manually place markers in addition to those positioned automatically 
during automatic measurement.

Addition of events

The events are represented by the symbol  if they are set during a measurement.

The events are represented by the symbol  if they are set manually in Advanced 
mode.

To add markers of events:

1 Select a cursor (A or B).

2 Use the direction keys or touchscreen to move the cursor to the place where you 
want to position a marker.

3 Press the keys: Advanced > Set Event.

4 An event marker  is displayed at the position of the cursor and a measurement is 
carried out on the event.

Measurement of slope before the marker starts just after the previous event (or at the 
end of the dead zone at the beginning of the fiber); measurement of slope after the 
marker stops just before the next marker or at the end of the fiber.
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Hints on the positioning of markers

– Do not add markers (with the Set Event key) after a manual measurement, as all the 
results will be recalculated automatically by the instrument.

– If two markers are too close together, they will appear on the trace and the table but 
no measurement will be carried out on the second marker: to obtain results for this 
marker, a manual measurement is necessary.

– If you press the Set Event key when the cursor is very close to a marker, the latter 
will be deleted.

Deleting events

To delete an event, move the cursor onto the event and press the Set Event key. The 
event selected will be deleted and a complete measure- ment, without this event, is 
carried out.

Deletion of events can cause incorrect measurement results.

Manual measurements

As soon as you have made an acquisition, with or without automatic measurement, 
you can make manual measurements on any event on the trace by means of the 
cursors A and B, in association with the func- tions of slope, detection of splice and 
calculation of ORL.

1 The manual measurements are accessible in the Results page, after pressing the keys: 
Advanced, Modify meas, then Manual Measurement.

Measurements of slope

To make a manual measurement of slope, press the RESULTS button to call up the 
trace and then:

1 Place the cursor A at the beginning of the section of the trace where the slope is to 
be measured.

2 Place the cursor B at the end of this section.

3 Press the Advanced key

4 Press the Modify Meas. key

5 Press the Manual key, then select Slope.

6 Press validation key (  or ENTER) : the slope of the specified trace section is 
displayed.
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Result of slope measurement

The result is displayed on the screen between the two slope indicators [and].

The measurement results are also available in the table:

1 Press Exit to return to the initial results page.

2 Select Trace using Trace/Summary soft key

3 Press validation key (  or ENTER) to display results table under the trace.

“Distance” shows the distance between the beginning of the trace and the end of the 
slope

If no result is displayed in the table, this means that the distance between the cursors 
A and B is too small.

Deleting a slope measurement

To delete a particular slope measurement result:

1 Superimpose the cursors A and B on the slope concerned

2 Select Slope (after, if necessary, pressing Advanced > Modify Meas.> Manual Meas.).

3 Press validation key (  or ENTER) : the slope of the specified trace section is 
deleted.

Measurement of ORL

It is possible to carry out an ORL measurement on a part of the fiber. Follow the 
following procedure to measure a part of the fiber:

1 Position the cursors A and B to delimit the section that you wish to measure.

2 Press the Advanced > Modify Meas.> Manual Meas., then select ORL.

3 Press validation key (  or ENTER) .

The ORL is measured for the section of trace defined.

Fig. 38 Manual Measurement results

Slope
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ORL on a saturated trace

If saturation occurs during an ORL measurement, the result is given with the sign <. 
This means that the actual ORL value is less than the value displayed.

Measurement of Reflectance

It is possible to carry out a reflectance measurement of a Fresnel for a reflective event.

Follow the following procedure to measure the reflectance:

1 Position the cursor A at the base of the peak

2 Position the cursor B at the top of the peak of the required Fresnel, or after the peak 
to calculate automatically the maximum reflectance.

3 Press the Advanced > Modify Meas.> Manual Meas., then select Reflec..

4 Press validation key (  or ENTER) .

The Reflectance value is defined in dB, and displayed in the trace in purple.

Fig. 39 Result of ORL measurement

Fig. 39 Result of ORL measurement
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Splice measurements

There are two methods of carrying out manual measurements of splices on the trace: 
the two-cursor method and the five-cursor method.

The five-cursor method is the more accurate, as it takes into account the difference of 
level between the slope before the splice and the slope after the splice. This method 
should be used whenever possible.

If very close events have created a dead zone preventing the measure- ment of slope 
by the five-cursor method, it is possible to use the two- cursor method. This considers 
the difference in level between the cursors.

Before performing one of these measurements, define in the Setup menu the splice 
detection threshold.

Two points
method To perform a splice measurement by the “two-points” method, display the

Results page, then:

1 Place cursor A exactly on the fault, then place cursor B after the splice that you wish 
to define.

2 Press the Advanced key, then Modify Meas.> Manual Meas., then select the function 
2 Pt Loss.

3 Press validation key (  or ENTER).

The splice marker is placed at the point defined by the first (left- hand) cursor and the 
result is displayed on the screen. If the fault is reflective, the reflectance value is also 
measured and displayed. These results are added to the table of results.

NOTE
If you try to measure a splice on a slope, the measurement is not carried out and the 
following error message is displayed: “Slope found between two cursors”.

Five points
method To carry out a splice measurement by the “five points” method:

1 Measure the slope preceding the fault to be measured, then the slope following it.

2 Place the cursor on the fault (between the two sections).

3 Press the Advanced key, then Modify Meas.> Manual Meas., then select 5 Pt Loss.

4 Press validation key (  or ENTER).

The splice event marker is placed on the cursor and the result is displayed on the trace 
and in the table of results.

NOTE
If no result is displayed, it is possible that the display threshold of the attenuation 
measurement result is higher than the attenuation that you are trying to measure.

NOTE 
If you try to measure a splice on a slope, the measurement is not carried out and the 
following error message is displayed: Slope found between two cursors.
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Memorization of the position of events

To memorize the position of events with a view to repeating the measure- ments at 
the same place during a future acquisition or on another trace, press the Advanced 
key, then select Lock Evts. The event memorization icon  will appear in the title bar.

The positions memorized will then be used in the subsequent measurements, either 
at the end of the manual acquisition, or when a stored trace is recalled.

NOTE This function memorizes the markers placed on the current trace. The following 
procedure is recommended to start a measurement with markers:

1 Carry out an automatic measurement.

2 Memorize the position of the events selecting Lock with the key in the Advanced 
menu. 

3 Add the manual measurements required (keys: Advanced > Manual Meas.).

CAUTION

If an event is added (with the Set Events key) after manual measure- ments have been 
performed, then all the events on the trace will be converted into AUTO markers 
and an automatic measurement will be performed using these events. The previous 
manual measurements will be lost.

Provided the event memorization icon  is displayed, the automatic measurement 
following the acquisition is carried out using the events which were present before the 
acquisition.

If you wish to make a measurement without events, deactivate memori- zation of 
events by pressing the Free Events key.

Overlay trace function

This very useful function enables up to eight traces to be displayed on the screen at 
once:

– either to compare traces acquired on a number of different fibers in the same cable,

– or to observe changes over time in traces taken of one and the same fiber.

Fig. 41 Example of overlaid traces
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Overlaying several traces stored in memory

If an event is added (with the Set Events key) after manual measure- ments have been 
performed, then all the events on the trace will be converted into AUTO markers 
and an automatic measurement will be performed using these events. The previous 
manual measurements will be lost.

To display up to 8 traces from the memory, deleting the current trace(s) already 
loaded:

1 Press the FILE button.

2 Select the files of the traces for display.

3 Press the Load key.

4 Press View trace(s).

5 When loading is complete, the Results screen appears: the first trace selected is the 
active trace (in green), the other traces being overlaid.

Display of traces in overlay

– The traces are shown in different colors (the active trace is green).

– Their serial numbers are repeated at the top of the screen.

– The OTDR markers are referenced on the active trace by the symbol, and on the 
other traces by vertical dashes.

Adding traces in overlay

With one or more traces already displayed, to add further traces to the display (the 
number of traces displayed cannot exceed 8):

1 Define at least one trace as reference

2 Press the FILE button, and in the Explorer, select the files of the traces to be added.

3 Press Load key.

4 Press the View Trace(s) or Load Trace + Config.

When loading is complete, the new traces are displayed in overlay with those that 
were defined as reference traces

NOTE
If the number of files selected exceeds the display capacity, a message gives warning 
that loading will be incomplete: only the trace or traces selected first will be displayed, 
up to the permitted limit of 8 traces.

Overlaying several traces stored in memory

If an event is added (with the Set Events key) after manual measure- ments have been 
performed, then all the events on the trace will be converted into AUTO markers 
and an automatic measurement will be performed using these events. The previous 
manual measurements will be lost.
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Swapping overlay traces

Measurements can only be made on the active trace and not on overlaid traces. To 
make measurements on a trace in overlay, it must first be swapped with the active 
trace.

1 Press the Trace key,

2 Press the  and  direction keys, as many times as necessary, until the active trace is 
displayed in green.

traces numbers

or
Click on the trace numbers in the upper right side of the result page until the trace 
desired is selected.

Removing a trace Removing the current trace in overlay

It is possible to remove a trace displayed. To do this, first select it (see previous 
paragraph), then successively press Advanced > Overlay > Remove Current Trace.

Removing all 
the traces in 
overlay

To remove all the traces except the current trace, then successively press Advanced > 
Overlay > Remove Other Traces.

Quitting the overlay menu

To quit the overlay menu, press the Exit key.

Reference Trace function

The reference trace function consists in defining trace(s) which will be «blocked» on 
screen and used as models before acquiring or loading other standard trace(s).

Use of the reference trace function in the Result page

Once one or several trace(s) is/are displayed, after an acquisition or loaded from the 
explorer:

1 If several traces are in overlay, check the correct current trace is selected

2 Go in the Advanced menu

3 Click on Overlay

4 Click on Set curve As Reference key.

The active trace becomes the reference trace;

– the icon  appears on the upper right hand part of the results table.

To define all the traces displayed as reference traces, click on Set All As Reference key 
(whatever is the active trace).
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Removing 
the reference 
trace(s)

To change one reference trace into a «standard» trace, select it using the Trace/Event 
key, and in the Advanced > Overlay menu, click once again on Set curve As Reference.

Performing an 
acquisition once 
one or several 
trace(s) is/are 
defined

To change all the reference traces displayed into «standard» traces, whatever is the 
active trace, go in the Advanced > Overlay menu and click on Set All As Reference.

Three situations can occur once an acquisition is performed:

– Only reference trace(s) is/are displayed: the trace acquired is added to the reference 
ones.

– Reference trace(s) and «standard» trace(s) are displayed: the reference trace(s) are 
«blocked», the standard ones are removed and the new trace acquired is displayed 
with the reference one(s).

– No reference trace(s) defined: all the «standard» traces are removed and only the 
new trace acquired is displayed.

Using the reference trace function in the explorer

A trace stored in memory can be set as reference trace before loading one or several 
«standard» trace(s).

To open one or 
several reference 
trace(s):

2 Define a zoom on this event.

2 Select the trace(s) to be defined as reference

3 Click on Load and select Reference = Yes on the key 

4 Click on View Trace(s) or Load Trace + Config.

The icon  appears on the upper right hand part of the results table.

To open «standard» traces to be added to the reference ones:

1 Go back to the Explorer

2 Select the trace(s) to be opened in the same screen as the refer- ence traces

3 Click on Load and select Reference = No on the key

4 Click on View Trace(s) or Load Trace + Config.
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Saving the trace(s) and generating a report

Once the results page is displayed, the trace(s) can be saved and a report can be 
generated directly from the results screen.

The traces saving and report generation can have already been performed 
automatically if the parameter Auto Store was defined on Yes in the Setup screen with 
the appropriate Save Mode (file only or file + txt or + pdf).

Saving results and creating a report from results page

To save the trace and generate a report:

1 Press Fast Report key  ->  .

A menu displays under the trace.

2 In the menu, configure the file saving mode (and the report)

A In the Save Mode parameter, select:

File Only to save exclusively the trace in a sor file

File + txt to save the trace in a sor file and to generate a txt file of the results

File + pdf to save the trace in a sor file and to generate a report in a pdf format

B In the Cable Id parameter, enter/modify the name of the Cable using the edition 
keypad.

C Modify the Fiber Number using the key  .

D
In the Direction parameter, select/modify the direction, to define if the measurement 
has been performed from Origin to Extremity (A -> B) or from Extremity to Origin 
(B -> A)

E E In the Location A and Location B parameters, enter/modify the name of Origin and 
Extremity.

3 Once saving is configured as wished, press Save All menu key

4 Enter a name for the file in the edition keypad. or

Click on Auto Filenaming menu key to apply the file name defined in the Setup screen, 
in Filenaming parameter

5 Press Enter to validate

Fig. 42 Fast report configuration

80 http://itnetworks.softing.com
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NOTE
The sor file and the txt or pdf file will have the same name. 
The icon  displays during saving process.

Once saving is completed, a sound is emitted onto the Platform.

NOTE
The file and the report are saved in the last storage media and directory selected.

Saving and report for traces in overlay

If several traces are displayed in overlay in the results page, one or several file(s)/
report(s) is/ are generated:

– If in the File Setup page (SETUP > File), the parameter File Content is defined with 
One Trace, one sor file and one pdf/txt report will be generated for each trace

Example: if 3 traces are displayed in overlay, 3 .sor files and 3 pdf/txt files will be 
saved.

– If in the File Setup page (SETUP > File), the parameter File Content is defined with All 
Traces, one single .msor file and one single txt/ pdf report will be generated, bringing 
together all traces.

Example: if 3 traces are displayed in overlay, one single .msor file and one single txt/
pdf file (with one trace per page; except if the results table is too long for one page) 
will be saved.

Opening a report

1 To open the report, press FILE hardkey

2 In the Explorer page, in the directory selected, select the file/report.

The file name is:

For the txt file: trace file_sor.txt

For the pdf file: trace file.sor.pdf

3 Press Load.

The file opens on the FiberXpert OTDR 5000.

81
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Fig. 43 PDF report

SLM (SmartLinkMapper) option

The SLM function is usable with OTDR trace exclusively and can be used either with a trace just acquired 
or with OTDR trace(s) saved onto the equipment.

1 Return to the result trace pressing RESULTS hard key (or load an
OTDR file from the Explorer).
The Trace/Summary menu key is replaced by the Trace/Smart- Link menu key.

2 Click on this menu key to select SmartLink. A screen as the following one is 
displayed:

Zone 1

Zone 3

Zone 2

Fig.44 SmartLink Function
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The screen is divided into three zones:
Zone 1: Graphical representation of the link, with icons symbolizing
the different events detected.
Zone 2: Link Table, which gives a summary of results for each wavelength, with results 
within/without thresholds in green/red (according to Alarm thresholds defined in the 
setup screen).
Zone 3: Alarms table (if any)

Show the detailed 
information of one 
event

The information concerning the event, its type and the alarm thresholds
defined for this event, can be displayed from the SmartLink screen.

1 Select the event for which information must be displayed, on the graphic using the 
touchscreen or direction keys. The event is highlighted in yellow once selected.

2 Click on the Event Diagnosis menu key. A small window displays. It describes:
– the event type
– the value above which it is on defect

Fig.45 Event Diagnosis

Event View

1 Click on Event View menu key to display a detailed description of
one event detected on trace.
2 Select the event to be described on graphic (highlighted in yellow).
The corresponding event description is displayed on the Zone 3, with a recall of alarm 
threshold for this event:

Fig.46 SmartLink Event View
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3 Click on View Trace to display the selected event in the results
table and zoomed on trace.

NOTE
The event is framed in red if it is above the alarm thresholds defined in the setup 
menu.
It is framed in green if it lies within the thresholds.
It is framed in grey if no alarm has been defined in the Setup menu

Changing the type 
of an event

Once the Event View is displayed, the type of event can be modified:
1 Select the event to be modified (framed in yellow)
2 Press Event Code menu key
3 Click on the event type to be applied to the selected event:

Fig.47 Event Code
4 Click on Exit to return to Event View.
5 Click back on Event View menu key to return to Summary screen 
or
Click on Trace View menu key to return to trace (and table) results screen

NOTE
The event modification is automatically applied on trace and in the results table.

Splitter sub-menus
The Splitter icon is different according to the menu key pressed in the
Splitter sub-menus

Example:

If the menu key   is pressed, the icon  is displayed
I the menu key   is pressed, the icon  is displayed.
Moreover, the icon and splitter configuration is different according to the 
number of «clicks» on one menu key.
Example with the menu key

• Click once: the icon is
• Click twice: the icon is
• Click three times: the icon is
• Click four times: the icon is

Click a sixth time to reset the event by default.
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Connection to the power meter

The type of optical connector used for the power meter is the same as the OTDR port.

With 2 OTDR ports, select the port of connection according to the wave- length 
available at each port (a label gives information at the back of the OTDR module).

It is not possible to use simultaneously the Source function and the Powermeter 
function, when both options are set onto the OTDR module, as they use the same 
connector.

Configuring the Power meter

To activate the function:

1 Press the HOME button

2 Select the power meter icon in the section of the OTDR Module
The icon turns yellow  .

10-POWER METER AND SOURCE OPTIONS 
OF THE OTDR MODULES
A variety of options are available when ordering an OTDR Module. Option:

The topics discussed in this chapter are as follows:

• “Connection to the power meter”
• “Configuring the Power meter”
• “Activating the Source function”
• “Result page”
• “Performing the power level measurement”
• “Performing the insertion loss measurement”
• “Storing and reloading results”

Connector

Fig. 48 Optical connector for the Powermeter or Source on the OTDR Module
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The effect of this action will to be to bring the power meter into use.

CAUTION The Powermeter icons of the singlemode port and the one of the Multimode 
port cannot be selected at the same time. When one is selected, it automatically 
deselects the other one.

Configuring the measurement parameters of the power meter

The measurement parameters can be accessed with the SETUP key.

Configuring the alarm parameters

Activation of the Alarm function: any result below the lower threshold or above the 
upper threshold will be displayed in red on the Results page.

Min and max 
thresholds

Choice of lower and upper thresholds for each available wavelength, from -60 to +40 
dBm (selected with the direction keys).

NOTE
To copy one value of the Lower or/and Upper threshold for all wavelengths, select the 
reference value and click on Update for All Wavel..

NOTE
A continuous push on direction keys increments the value by 10 dBm.

3 On the Zoom/Shift key, select Shift.

4 Displace trace manually on touchscreen toward left/right or upward/ backward. or

Use the direction keys to shift the trace in the desired directio 

Configuring the Measurement parameters

In the Setup page, press Measur’t soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Measur’t)

Wavelength Select wavelength: Auto: the wavelength of the input signal will be automatically 
detected and selected to perform the measurement: 1310, 1490, 1550, 1625 or 1650 
nm: measurement performed at specified wavelength.

Fig. 49 Configuration of power measurement



87

Beep on
modulation Select if a sound must be heard when a modulation occurs (Yes / No)

Unit Unit of power displayed: Watt, dBm for displaying absolute power dB for displaying a 
result relative to a reference (link loss)

Reference
level

If dB units were chosen in the previous line, selection of the reference value for the 
wavelength selected. Using the direction keys, first choose the wavelength, then press 
the > key to access choice of the value (+XXX.XX), then confirm this value with the 
ENTER key. This reference is also automatically available, in the Results page, using the 
Set as Reference key.

Attenuator 
compensation

Choice of level to be applied to the wavelength chosen for measurement to 
compensate for the loss due to the external attenuator (+XX.XX dB). First use the 
direction keys to choose the wavelength, then press to access choice of value, then 
confirm this value pressing ENTER.

NOTE
To copy a Reference Level/Attenuator Compensator on all wave- lengths, select the 
reference wavelength and click on Update for All Wavel..

Configuring the Link parameters

In the Setup page, press Link soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Link).

NOTE The softkey Copy File/Link To all is displayed when one parameter is selected 
in the Link or File Setup page and when the Powermeter or Source function is 
active. It allows to apply the Link and File configuration parameters of the current 
applications to all the other active Fiber Optic applications (powermeter and source). 
The information entered in the Link Description window concerns the editing and/or 
the modifications of the cable and fiber parameters. When a trace is recalled without 
recall of the configuration, the parameters of this trace will be present only in its 
signature.

Fiber ID

Select the parameter Fiber Id and enter a name for the fiber, using the edition keypad.

Fiber Number / Fiber Code

The parameter Fiber Number becomes Fiber Code if, in the Cable Structure window, 
the Cable Content parameter is defined on another parameter than Fiber (Ribbon/
Fiber, Tube/ Fiber or Tube/Ribbon/ Fiber).

The fiber code corresponds to the fiber number if, in the Cable Structure, the 
parameter Color coding is defined on No.

The fiber code corresponds to the fiber color if, in the Cable Structure, the parameter 
Color coding is defined on Yes.
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Select the parameter Fiber Number/Fiber Code and modify the parameter using the 
left and right direction keys.

The fiber number can be automatically incremented/decremented at each new file 
save if it has been configured in the File Setup page (see

NOTE The Fiber Code and the fiber number concatenated with Fiber Name are 
interdependent: they are incremented or decremented at the same time. However, 
the fiber number remains a number only, while the fiber code is alphanumerical. 
Whether it includes a color code or not it may be composed of one, two or three parts

Fiber and
cable
parameters
used in the
example:

Fiber Name: ’Fiberx’ 
Cable Content: ’Tube/Fiber’ Max Tube: 12 
Max Fiber: 24 
Coding used for the fiber and the tube: TIA

Fiber N Fiber N+1
Color Code Yes No Yes No
<Fiber Name> Fiberx24 Fiberx24 Fiberx25 Fiberx25
<Fiber Code> Bl/Aq- 1/24 Gold/Bl 2/1

Change Fiber Nbr

the Setup page, press Measur’t soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Measur’t)

Increment the fiber number is automatically incremented at each new file-save.

Decrement the fiber number is automatically decremented at each new file-save

User defined Use Edit Number softkey to enter the increment/decrement value for fiber number.

NOTE To decrement the number, enter the sign «-» before the number. Example: -1. 
Min: -999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified.

Extremities are different

In some cases, it is interesting to save different information for the origin and the 
extremity of the cable.

Fig. 50 Example of incrementation of fiber code
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If this option is validated, it is possible, after selecting the extremity to be edited in the 
Cable Structure menu, to modify the values specific to the cable (cable name, color 
coding, content of the coding), for each of these extremities.

To display/modify the data specific to the fiber (name and code), it is necessary to 
change direction temporarily. In the “O->E” direction, the information on the origin 
can be edited, and in the “E->O” direction, that on the extremity.

Cable Id

This parameter allows to enter an identification of the cable, using the Edition menu.

Direction

The direction shows if the acquisition has been made from the origin to the extremity 
(A->B) or from the extremity to the origin (B->A). Changing direction makes it possible, 
when different extremities are handled, to see the parameters of the fiber for the 
other extremity.

Location A

The name of the Location A of the link may be entered here.

Location B

The name of the Location B of the link may be entered here.

Cable structure

This line opens a sub-menu, all the parameters of which can be different for each 
extremity.

NOTE
The Cable Structure window is specific to an extremity. Each structure keeps its own
parameters by default.

Fig. 51 Cable structure menu
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Modifications made to the one are not automatically applied to the other. Thus, after 
the values relating to the origin have been modified, it is normal not to find these 
same values entered for the extremity.

View extremity If extremities are declared as different, this parameter allows to navigate between the 
Extremity and Origin parameters.

Cable Id If the extremities are different, you can specify the cable identification for the origin 
and the extremity.

Color Coding
Choice of whether or not to apply a color coding to the fiber. This choice is made at 
link level, as all the fibers of a given link, for a given extremity, will be coded the same 
way. This choice modifies the result of the <Fiber Code> line.

Cable content Shows how the color code is to be used (see figure

– Fiber Only the color code of the fiber is proposed (example: «Gold»)

– Ribbon/Fiber The color code of the fiber is preceded by that of the ribbon, and separated by a ’/’ 
(example: ’Bl/Or’)

– Tube/Fiber The color code of the fiber is preceded by that of the tube, and separated by a ’/’ 
(example: ’Br/ Or’)

– Tube/ Ribbon/ 
Fiber

The color code of the fiber is preceded by that of the tube, then by that of the ribbon; 
the three being separated by a ’/’ (example: ’Br/Bl/Or’).

Max tube Shows the maximum number of tubes in the cable for the extremity selected. This 
information influences the automatic coding of the fiber.

Max ribbon Shows the maximum number of ribbons in the cable for the extremity selected. This 
information influences the automatic coding of the fiber.

Max fiber Shows the maximum number of fibers in the cable for the extremity selected. This 
information influences the automatic coding of the fiber.

NOTE
Some parameters are not valid in the configuration selected. Thus, if no tube is 
selected in Cable Content, all the lines relating to the tube concept will be deactivated 
(grayed out in the menu).

Tube Coding, 
Ribbon Coding, 
Fiber Coding

The lines Tube Coding, Ribbon Coding and Fiber Coding enable selection of the color 
coding of the tube, the ribbon and the fiber from 5 different codes described below: 
TIA, USER 1, USER 2, USER 3 and USER 4.

Code
Definition

The Code Definition line opens a sub-menu, with which the different color codes 
possible on the instru- ment can be displayed and modified.

The standard code (TIA) may be displayed but it cannot be modified.

The other codes, called by default USER1, USER2, USER3 and USER4, can be entirely 
personalized.

– Edited code
– Code name

selects the code for display or modification. 
to give a new name to the code selected, press the  key, which calls up the edit menu.

– View codes displays the color codes 1 to 12, 13 to 24 or 25 to 36.



91

– Code 1...23 Use the arrow  to modify the codes if necessary.

Operator

Use the arrow  to enter the name of the operator carrying out the measurement.

Comment

In contrast to the other data in this menu, the comment is specific to a fiber. This line 
is thus used to enter a new comment and not to display it. The comment appears at 
the top of the screen, with the other parameters of the fiber.
This comment will remain available for the next acquisition, unless it is deleted. It is 
also saved when a trace is saved with a comment.

Configuring the File parameters

The File storage parameters must be also configured, in order to define how the 
results will be saved on to the Product Name/Family Brand.

In the Setup page, press File soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on File).

Dir

This parameter cannot be configured, and display the directory selected by default 
into which the file(s) will be saved (the last directory selected).

To modify the directory, go to the Explorer page and select another directory.

Filenaming

Select Filenaming parameter and press the right arrow key to modify the name of the 
file for the result trace.

In the edition keypad, enter a name manually for the file and/or use the predefined 
parameters available (Cable_Id, Fiber_Num...). Then, press Enter to validate.

Fig. 52 Filenaming - Edition keypad

Predefined parameters
for naming files
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or
Press Default Filename to apply the name by default to the file: Fiber[Cable_Id][Fiber_
Num]_[Lambda]_[Direction] The name of the file is displayed in grey under Filenaming 
parameter

Save Mode

When a trace or more is displayed, in the parameter Save Mode, you can select three 
types of methods for storing traces:

File Only only the trace(s) is/are stored in one/several file(s), with its extension (.sor, .msor)

File + txt the trace(s) is/are stored in one/several file(s), with its extension and one txt file is 
also generated.

Activating the Source function

The Source function is an option chosen at the time of order and incor- porated into 
the OTDR module in the factory. To activate the function:

1 Press the HOME button

2 Click on the icon Source in the OTDR Section The icon turns yellow. 

CAUTION
The Singlemode and Multimode Source icons cannot be selected at the same time. 
When one is selected, it automatically deselects the other one.

Result page

The results page, automatically displayed after the icon selection, gives the 
information relating to the measurement in progress, results previously saved and the 
commands available for measurement and saving.

Result page of the Power meter

The power measured by the power meter is displayed in large charac- ters, in the units 
selected in the Setup menu, together with:

– the mode of transmission of the signal measured: continuous (CW) or modulated to a 
frequency of 270Hz, 330Hz, 1KHz, or 2KHz.

– the wavelength of the signal measured.

– the reference level expressed in dB.

– the level of Attenuation Compensation.
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Table of results

For one and the same fiber, the power meter displays a table of 9 results 
corresponding to the different possible wavelengths. The table shows the power 
measured in dBm, the relative power (in dB) and the reference level in dBm (if units = 
dB), together with the mode.

– A measurement result is displayed in the table when the Keep Result softkey is 
pressed.

– The Clear Table softkey orders deletion of all the results displayed in the table.

– If the Alarm function has been activated, any result that exceeds the selected 
thresholds appears in red in the table. Otherwise, results are shown in the table in 
green.

– When the instrument is switched off, results present in the table are saved.

Laser On / Laser Off Activation or shut-down of the laser (same function as the START/ 
STOP button)

When the laser is on, the icon is displayed.

The parameters of the source can be accessed directly on the result screen:

Wavelength
To change the wavelength when a multi wavelength source is present (depending on 
option).

The wavelength value is displayed.

Mode To vary the mode of emission of the source.

Possible modulation values are:

Fig. 48 Results and commands of the power meter

Fig. 53 Source result page
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– 270 Hz / 330 Hz / 1 kHz / 2 kHz 
– Auto (the sources emit on determined frequencies to enable the power meter to 
detect the wavelength used automatically)
 – TwinTest (cyclical emission on all available wavelengths for a few seconds on each 
wavelength),
– CW (continuous emission) The mode used is displayed, above the icon  .

Standard Reference: to perform a side by side reference measurement

If the power meter function is selected onto the equipment (either on Base-Unit or on 
OTDR module) the menu keys are different on screen:

– Source Config: allows to display the Wavelength and Mode menu keys
– The Source Reference menu key allows to open a sub-menu with the following keys:

Standard Ref To perform a reference in side by side mode (see

Jumper Ref To perform a reference measurement in loopback mode

Performing the power level measurement

The power meter is started up as soon as the function  is activated in the HOME 
page.

It is not possible to use simultaneously the Source function and the Powermeter 
function, when both options are set onto the OTDR module, as they use the same 
connector.

Power measurement is automatically updated in consequence. The value «<-50 dBm» 
is displayed when the laser is switched off and if the source output is looped on to the 
power meter input.

1 Connect the light source to be tested to the rear connector

2 In the SETUP menu, choose the units dBm or Watts.

3 Press the START/STOP key to start the measurement. The result will appear in the 
results page and can be memorized in the table

4 Press the START/STOP key to stop the measurement.

Performing the insertion loss measurement

Using light source and power meter options, an insertion loss measure- ment can be 
performed, having previously carried out a reference measurement.

Setting the zero value of the power meter

1 Fix the plug over the optical input of the power meter so that no light can reach the 
photodiode of the power meter. If the zero adjustment is made without this plug, an 
error message may be displayed, as the photodiode will detect too much light.

2 In the Results page, press Powermeter config. > Zero soft key and validate
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It is important to set the zero of the power meter before making any measurements 
where accuracy is required, as the noise from the ger- manium photodiode fluctuates 
over time and with variations in temperature.

Carrying out the reference

Using two FiberXpert OTDR 5000 platforms with an OTDR module including a laser 
source option and a Power meter option, an insertion loss measurement in continuous 
wave can be performed.

Two types of reference are available: referencing in side by side mode and referencing 
in loopback mode.

Carrying out the side by side reference

This reference can be carried out when both units are connected together meaning 
they have to be at the same location.

1 Before connecting fiber/jumper, use appropriate cleaning tool to clean connector 
endfaces.

2 Connect the two jumpers together via a bulkhead connector.

3 Set, on equipment (1), the OTDR light source as “Standard Ref”

A Press the HOME key

B Use the arrow keys or touchscreen to select the Source function on Home page  .

C Press RESULTS key

D In the Results page, press Source Config.> Source Reference > Standard Ref

E Press Exit and go back to the result Page

F Select the Twintest mode by skipping through the different modes

G Press Laser On key to activate the source

4 Set, on equipment (2), the power meter (from OTDR module, from the Base-unit or 
from USB) as “Standard Ref”

A Press the HOME key

Fig. 54 Side by side reference
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B Use the arrow keys or touchscreen to select the Powermeter function in Home page.

C Press RESULTS key .

D
In the Results page, press Pow.Reference > Standard Ref.  
The actual power level is set as the new reference level for the selected wavelength. 
Then, the displayed value is around 00.00 dB.

E Press Exit and go back to the Results page.

The reference levels are stored into the unit, and have been automati- cally filled into 
the setup.

Storing and reloading results

File Setup Click on the button FILE to access the File setup.

Storing results

In order to save the results of a measurement, click on FILE and select
Store trace. Two files are being saved:
– The first file is to be used with the product and allows to retrieve all measurement 
results. It is saved with the extension .Lts.
– The second file is a ASCII file using tabulations to separate values.  
It is saved with the extension «.txt» and can be opened by the 4000 Platform via 
the Web Browser. It has been designed to be used with a spreadsheet program on 
a PC where it allows to retrieve all measurement results and format them in a nice 
customized table.

Loading
results

In order to load the results of a measurement, select a file with the extension «.Lts» in 
the file explorer, click on Load > View trace.
The LTS tab is displayed with the loaded results in the table.



97

Scope feature

Overview This feature enables you to verify that your optical connectors are in perfect shape 
and very clean condition.

The Digital Probe Microscope is a portable handheld microscope used to view and 
inspect both the bulkhead (female) and patch cord (male) sides of fiber connectors as 
well as other optical devices, such as transceivers.
The microscope requires an inspection tip and is connected to the Unit with a USB 2.0 
connector.

11-SCOPE
The scope function is a hot-plug feature enabled directly when inserting a Softing IT Networks GmbH 
microscope supplied as an option:

The topics discussed in this chapter are as follows:

• “Scope feature”
• “Installation of tips”
• “Configuring the Microscope”
• “Starting up with the scope”
• “Launching a test of the connector and fiber end-face”
• “File menu”

Inspection tip
QuickcaptureTM button Instantly 
captures (and analyzes) fiber image
Focus Control
Magnification Control

Barrel assembly USB 2.0 connector

Latch lock Squeeze 
both ends to release

6 FT COIL Cable

Fig. 55 Probe components
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Installation of tips

The Pass/Fail analysis function on the FiberXpert OTDR 5000 can only be used with 
certain inspection tips mounted on the microscope.

Various tips, patchcords and bulkheads types, are available

Configuring the Microscope

Scope
connection

1 Plug in your Softing IT Networks GmbH scope into a USB port of the FiberXpert OTDR 
5000.

2 Push the button Home

3 Validate the Scope function .

4 Connect probe with the fiber being inspected.

You may select this option while other options are already selected.

Configuring the Scope

1 Press SETUP key to configure the test.

The following screen displays:

Test On the line Profile, select the Profile which will be used for the test of fiber 
connector:

– SM_UPC: Pass/Fail criteria for single-mode UPC connectors from IEC 61300-3-35 
standard.

– SM_APC: Pass/Fail criteria for single-mode APC connectors from IEC 61300-3-35 
standard.

– SM_PC: Pass/Fail criteria for single-mode PC connectors from IEC 61300-3-35 
standard.

– MM_: Pass/Fail criteria for multimode connectors from IEC 61300-3-35 standard.

Fig. 56 Scope Setup
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Profiles contain the analysis parameters by which PASS/FAIL criteria are determined.

Once the line is selected, you can also add a new profile, clicking on the Add Button

Tip On the line Tip, select the tip set onto the microscope to connect fiber for inspection.

Capture
button This parameter allows to select the action of the Quick Capture button onto the Scope

Freeze & Test pressing the button will automatically perform a test of fiber and freeze the result

Freeze image pressing the button onto the Scope will automatically freeze the live image.

Auto Center This parameter allows to select if the scope image must be centered on screen (select 
Yes) or not (select No).

File

The File box allows to configure the saving of scope results.

The Dir parameter is displayed in grey, and indicates the directory into which the 
results will be saved. To change the directory, press FILE hardkey and select another 
directory from the file Explorer page; then press SETUP hard key to return to Scope 
Setup page.

On the line Filenaming, use the edition keypad, which will display by clicking on the 
right arrow key, to enter a specific name for the file. You can enter manually a name 
and/or use pre-defined parameters (Fiber Id, Cable Id, Locations...).

The line below Filenaming shows the name of the file according to the parameters 
entered.

In the Logo parameter, click on right arrow key and select in the Explorer a JPG file which 
will represent the Logo displayed on the upper left part of the report

Fiber

The Fiber box allows to configure the fiber plugged to the scope.

On the line Fiber Id, use the edition keypad, which will display by clicking on the right 
arrow key, to enter a specific name for the fiber.

Pre-defined parameters
for filenaming

Fig. 57 Edition keypad for filenaming
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On the line Fiber Number, use the numeric keypad, which will display by clicking on 
the right arrow key, to enter the fiber number.

On the line Change fiber Nbr, select if the fiber number must be modified after each 
results saving:

No: the fiber number is not modified at each saving

Increment; the fiber number is automatically incremented at each results saving

Decrement: the fiber number is automatically decremented at each results saving.

Link Description

The information entered in the Link Description window concerns the editing and/or 
the modifications of the cable and fiber parameters.

Cable Id This parameter allows to enter an identification of the cable, using the Edition menu.

Direction

The direction shows if the acquisition has been made from the origin to the extremity 
(A- >B) or from the extremity to the origin (B->A). Changing direction makes it 
possible, when different extremities are handled, to see the parameters of the fiber 
for the other extremity.

Location A The name of the Location A of the link may be entered.

Location B The name of the Location B of the link may be entered.

Company Enter the name of the company carrying out the test.

Operator Enter the name of the operator carrying out the test.

NOTE
All parameters of the Link Description box will appear in the pdf report or jpg file 
generated from a test results page.

Press Exit to return to the Results screen of the scope

About page

On the Setup screen, the softkey About, on the right of the screen, allows to display 
information on scope and current test result displayed

1 Press About softkey to display a page as the following one:

Fig. 58 Microscope: About page
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Starting up with the scope

Once the FiberScope icon is validated:

1 Press RESULTS hard key

Use the Focus Control button onto the microscope to adjust the image quality and 
sharpness.

NOTE
To switch from Scope page to FO results page and vice-versa, press the RESULTS hard 
key for about 2 seconds (a beep is emitted).

Freeze mode

Once the image is acceptable, you may freeze the picture. This feature allows to store 
in memory the resulting picture.

Freezing a scope result does not store the picture in a file. The result will be lost if the 
instrument is shut off, or if more than 3 pictures are frozen

NOTE
The button set on the lead, or the QuickCapture™ on the microscope allows to freeze 
the picture or to take a snapshot.

High Mag. / Low Mag.

The High Mag./Low Mag. menu key allows to switch the display from High to Low 
magnification and vice-versa.

This function is also available pressing the button directly on the microscope

Camera mode

If you are in Freeze mode, or in Mosaic mode, with a picture selected (see “Mosaic 
Mode” on page 59), press Camera menu key to return to live camera picture.

Use the focus control to adjust the focus of the image

Fig. 59 Example of the result using the microscope

Sharpness level
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Launching a test of the connector and fiber end-face

Once the display is correctly adjusted (magnification, sharpness...), a test of fiber 
connector can be launched. To launch the test:

1 Press Test key to launch the test of plugged fiber connector.

The test is completed:

– once the LED Testing is no more lit in red

– once the  icon is no more displayed on the upper banner

– once a screen as the following one displays:

NOTE
To configure Pass/Fail criteria, see “Configuring the Scope”

Once the display is correctly adjusted (magnification, sharpness...), a test of fiber 
connector can be launched. To launch the test:

A summary of test results is displayed on the right, upper part of the screen.

– Zone A: Core zone: it is the area surrounding the core

– Zone B: Cladding zone. It surrounds the majority of the fiber cladding.

– Zone C: Epoxy ring.

– Zone D: Ferrule/Contact zone: it identi- fies a portion of the ferrule near and around 
the fiber

NOTE
To return to a Live Camera image, press the Camera key; or press the Full Screen/ 
Mosaic key view both the live image and a test result simultaneously.

In Mosaic mode, the result of the test only displays Pass or Fail information; the status 
of each zone is dis- played only in full screen mode.

Profile
selected
in the Setup
page

Summary of
Test results

Test result in
High mag.

Fig. 60 Test results

Zona A
Zona B
Zona C
Zona D
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Overlay

The Overlay key allows, when selected, to display the limits of each zone and to 
display with colors the defaults on the image.

When the key is deselected, the zones and defaults are not graphically identified.

This function is also available in Mosaic Mode.

Mosaic Mode

It is possible to display only one picture in full screen (640 * 390 pixels) or up to four 
pictures (320*180 pixels each, including the live camera picture) in mosaic mode. Use 
the key Full scr./Mosaic to switch from one mode to another.

– You may select one of the pictures by clicking on it.

The selected picture is framed in green.

The tool bar on the right varies according to which picture is selected (camera, or 
static picture):

Mosaic Mode

Test Allows to launch a (new) test of the connector

Freeze The live picture from the camera is frozen but does not replace the live picture at 
position 1. The new snapshot is placed at the second position, and all existing pictures 
are pushed to the next position.

If all positions were taken, the picture that was once at the fourth posi- tion is 
unloaded from memory. Frozen pictures and snapshots are lost, unless they were 
saved on the internal memory.

Fig. 61 Mosaic mode

Position 1 :
LIVE CAMERA
Selected picture

Position 2:
File saved on disk
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High mag./
Low mag. allows to modify the live display from high to low magnification and vice-versa

Picture selected: Image

Comment allows to add a comment to the selected picture

Save
allows to save the selected picture in the directory Scope, in the disk of the Unit. Press 
Save key, enter a name for the jpg file and validate. This key is not available with jpg 
files other than those resulting from scope application.

Overlay allows to display or hide the limits of each zone and the defaults on image from a test 
result.

High mag./
Low mag.

allows to switch all the images from scope test results from high to low magnification 
and vice- versa.

Adding a comment

The key Comment allows you to enter/modify a comment to your picture if necessary. 
This comment appears at the bottom left of the picture.

The right bottom of the frozen picture also contains the date of the acquisition (where 
the picture was frozen).

NOTE
Both the comment and the date will be saved with the picture.

Loading a picture

It is possible to retrieve and load a picture stored in the Scope directory and display it 
in the Scope page.

1 Press the FILE button.

2 Press Explorer.

3 Select the JPEG file to be loaded via the Explorer

4 Click on Load

Recognized pictures are images resulting from the Scope option and saved on disk via 
the FiberXpert OTDR 5000.

Some pictures resulting from the Scope option may appear nevertheless 
unrecognized, if they have been stored with a different Scope application, or if the JPG 
file has been opened and modified under another JPG editor.

Even though the JPG editor of the Scope function has been designed to display Scope 
pictures in black & white, it is also possible to open any JPG valid file and display in 
color the corresponding picture. That picture is enlarged or shrunk to the size of the 
display.
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File menu

Saving the test
result in a jpg
file

Once the test has been performed, and the result is displayed on the FiberXpert OTDR 
5000 screen:

1 Press FILE key

2 Click on Save key to save a jpg file of the test result on the disk of the FiberXpert 
OTDR 5000.

3 On the edition keypad, enter the name of the jpg file

4 Press Enter to validate.

The file is automatically saved on the disk, in the directory Scope  (icon).

Generating a report

1 Check the correct test result is selected (framed in green in mosaic mode).

2 Press the FILE button, then the Report key

3 On the edition keypad, enter the name of the pdf file and press ENTER.

The report generation is completed once the icon  is no more displayed on the 
upper banner.

Display of the report

Once the report has been generated:

1 Press FILE hard key.

2 On the right menu keys, press Explorer soft key.

3 In the File Explorer, select the pdf report just created.

4 Press Load.

Fig. 62 PDF report of Scope test result
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Establishing connection

The connection between FiberXpert OTDR 5000 and the PC can be done directly, or via 
a local network.

The transfer of the interface can be done using a VNC window on PC.

For an intensive use of the deport screen or when it is used via a WAN network, it is 
strongly recommended to use a dedicated VNC client. The VNC clients recommended 
are Tight VNC (V 1.2.9 or later) and Real VNC (V 4.1.1 or later).

Connecting the FiberXpert OTDR 5000 and the PC

1 Connect the FiberXpert OTDR 5000 to the PC via an Ethernet cable, using the RJ45 
connectors set on both equipments.

2 Check the network connection on the PC is set in Dynamic mode.

12-TRANSFERRING THE FIBERXPERT OTDR 5000
INTERFACE
The FiberXpert OTDR 5000 can be used in combination with a PC in order to transfer the Unit Interface onto 
a PC, or to access the internal memory or USB memory stick contents on the PC.

Topics described in this chapter are as follows:

• “Establishing connection”
• “Transferring the Interface”
• “Virtual control buttons bar”
• “Equivalence between the keyboard and FiberXpert OTDR 5000”

Fig. 63 Connection FiberXpert OTDR 5000 and PC
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Picture selected: Image

1 In the Home page of the FiberXpert OTDR 5000, validate the Settings icon.

2 In the System Settings page, in the I/O Interfaces box, configure the following 
parameters:

Remote Screen

Remote
screen = Session or Permanent must be confirmed in both cases, in the Interface E/S window.

No the screen cannot be remote on to a PC or on to another FiberXpert OTDR 5000.

Session Mode the Remote screen function is inactive once the FiberXpert OTDR 5000 is switched off.

Permanent
Mode

the Remote screen function is still active when the FiberXpert OTDR 5000 is switched 
off and restarted.

Permanent
with password

same function as the Permanent mode, with an access to the equipment via VNC 
protected by a password: 42000

The password to access VNC can be modified:

1 Click on the menu key Change password.

2 Enter the current password in the Edition keypad and press Enter to validate.

3 Enter the new password and press Enter to validate.

Loading a picture

Parameters of the local Ethernet network to which the FiberXpert OTDR 5000 is 
connected:

Config 1 to 4 static mode enabling input of the configuration of 4 sites. If this parameter is selected, 
the following parameters must be entered:

– Site Name the user can enter the name of the site in the Edit menu.

– IP Address IP address of the FiberXpert OTDR 5000

– IP Mask address of the mask of the sub-network

– IP Gateway IP address of the machine enabling access outside the sub-network.

– DNS1 IP address of the machine providing the IP address on the basis of the name

– Domain 
name name of the local network to which the 2000 Plat- form is connected.

– Dynamic
in this mode, which requires a DHCP server, the FiberXpert OTDR 5000 requests 
an IP address from this server which will be allocated dynamically if dynamic host 
configuration is activated on the local network.

After selecting this mode or after power-on, the FiberXpert OTDR 5000 tries to 
establish a connection to obtain an address from a DHCP server. If for any reason, this 
process fails, the FiberXpert OTDR 5000 reverses to static IP address mode with User1 
IP address.

1.Domain Name Server
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NOTE
Once the FiberXpert OTDR 5000 is connected to the network, the icon indicates the 
connection is working.

Proxy > Use proxy

1 Select No if no proxy is used.

2 If Manual has been selected, enter the Proxy Address.

3 If Auto has been selected, enter the Pac Address.

4 Note the IP Address displayed in the System Settings page.

5 Wait about 10 seconds the connection is established.

The FiberXpert OTDR 5000 Interface can now be transferred onto the PC, or the 
internalmemory or USB key contents can be transferred on PC.

Connecting the FiberXpert OTDR 5000 and the PC

Once the connection is established between the FiberXpert OTDR 5000 and the PC, 
proceed as follow:

1 Open your browser on the PC.

2 Considering 10.33.18.93 is the IP Address of the FiberXpert OTDR 5000, enter the 
following address in the browser window: http://10.33.18.93:5800

3 Press Enter to validate.

A VNC window opens, demanding a password

4 Press OK without typing any password.

The screen of the FiberXpert OTDR 5000 appears offset on your PC.

Note the IP Address

Fig. 64 Example of configuration for I/O Interfaces box
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You can use keyboard mouse of the PC to control the FiberXpert OTDR 5000

NOTE
Once Remote screen is accessible via VNC, the  icon displays on the upper banner 
of the screen until the connection is cut or the FiberXpert OTDR 5000 is switched off.

Virtual control buttons bar

It is possible to emulate hard keys with Virtual Control buttons. This virtual control 
buttons bar is especially useful when the FiberXpert OTDR 5000 screen is exported on 
a remote PC.

To display those buttons, click once on the top of the screen in the status bar, at the 
same height than the date and time.

The virtual control buttons bar is displayed during a few seconds. You may click on any 
of these buttons to obtain exactly the same results than using the hard keys on the 
front panel of the FiberXpert OTDR 5000.

The FiberXpert OTDR 5000 Interface can now be transferred onto the PC, or the 
internal memory or USB key contents can be transferred on PC.

Click to install TightVNC
software on your PC

(not mandatory)

Fig. 65 VNC window

Fig. 66 Virtual control buttons bar
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Equivalence between the keyboard and FiberXpert OTDR 5000

The PC keyboard can replaced all the buttons and keys of the FiberXpert OTDR 5000 
except the ON/OFF button:

– The menu keys to the right of the screen are replaced by the function keys F1 to F6.

– The buttons below the screen are equivalent to Ctrl + a letter (see table below).

– The direction keys have the same function on the external keyboard and on the 
FiberXpert OTDR 5000.

Function on
the FiberXpert
OTDR 5000

External keyboard

HOME Ctrl + H

SYSTEM
SETTINGS F12

SET-UP Ctrl + U

FILE Ctrl + F

RESULTS Ctrl + R

START/STOP Ctrl + S

EXPORT Ctrl + Pa

Menu keys 1
to 6 (from top
to bottom)

F1-F6

ABOUT F11

Save and quit
(Exit) Entrée/Enter

Quit without
saving (Abort) Escape/Echap.

a. The Export function is available directly on the FiberXpert OTDR 5000 pushing 
simultaneously the left and right arrow keys.

NOTE
Those equivalences are also valid with a keyboard directly connected to the FiberXpert 
OTDR 5000 via one USB port.
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Configuring the Web access

Before using the Web Browser on the FiberXpert OTDR 5000, check/modify the proxy 
configuration in the System Settings page:

1 On the Home page, press Settings key

The System Settings page displays.

2 Select Proxy parameter in the I/O Interfaces box to open a sub- menu.

3 Configure the parameter User Proxy

– If Manual is selected, enter the Proxy Address with edition keypad

– If Auto is selected, enter the Pac Address using the edition keypad.

Starting the web browser

1 In the Home screen, select Web Browser  icon.

The web browser is launched.

13-WEB BROWSER
The FiberXpert OTDR 5000 allows to access to internet, using the Web Browser installed on the equipment.

The topics discussed in this chapter are as follows:

• “Configuring the Web access”
• “Starting the web browser”
• “Creating bookmarks”
• “Opening a PDF document”
• “Leaving the web browser”

Fig. 67 Proxy configuration
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Opening an internet page

Once the Web Browser is displayed, you must enter the internet address.

1 Set the cursor in the address bar:

a Use the mouse connected via USB port on the FiberXpert OTDR 5000 or the 
mouse of the PC if the screen is deported via VNC application on the PC, or use the 
touchscreen.

b Click on the menu key so that it becomes. This allows to move the cursor toward the 
address bar.

2 Once the cursor set onto the address bar, enter the address: 

a Using a keyboard connected to the FiberXpert OTDR 5000 USB port or the keyboard 
of the PC with a deport of the screen via VNC, enter the entire address of the site to 
be opened.

b If none keyboard is available:

– click on the menu key to display the virtual keyboard and enter the address using 
the buttons on the FiberXpert OTDR 5000 or clicking directly on characters.

3 Push the ENTER hard key.

The page opens

If an error message is displayed in place of the internet page, verify the address you 
typed, or check the configuration.

Once the Web Browser is open, press the key to display on the right of the screen, the 
buttons used to navigate.

Navigation into the Web Browser

Icon Definition

Go to the previous or next page loaded

Refresh the actual page

Exit the Navigation menu

When a link is available, the arrow cursor becomes a hand cursor

Fig. 68 Web Browser page
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Creating bookmarks

Once a page is opened, you can apply it a bookmark, in order to get a shortcut toward 
this page.

Once the internet page for which a bookmark must be created is opened:

1 Click on  to open the dialog box for bookmarks creation.. A new tools bar is 
displayed on the right of the screen.

2 Click on menu key  to add a bookmark for the page displayed

3 Click on  to edit the bookmark, and modify if necessary the name of the 
bookmark.

Click on Ok to confirm the modification or Cancel to cancel the modifications.

– Click on  to open the page of the bookmark selected in the list

– Click on  to delete the selected bookmark from the list

– Click on  to exit bookmark menu and go back to Web Browser.

Opening a PDF document

PDF documents may be opened and read within the Web browser.

1 When you click on a link toward a PDF file, a dialog box during loading is displayed.

2 Once loading is completed, click on Ok to open the pdf file.

Fig. 69 Bookmark edition

Fig. 70 Downloading a pdf file



114 https://itnetworks.softing.com

Fiber pert
O TDR 5000

Click on the menu key  to go back to the web browser.

NOTE
The web browser will open a PDF document, not a URL including a PDF file.

The PDF is also automatically saved on the disk of the Platform.

Leaving the web browser

Depending on how long you want to leave the web browser and on your connection 
mode, you may:

– Leave the web browser running and switch to another task. To do this, click on the 
HOME button.

The web application is still running in the background. Nevertheless, you have now a 
complete access to all the FiberXpert OTDR 5000 functionalities.

To go back, you must select again the Web Browser in the Home page. The application 
will reopen much faster, and all your environ- ment will be the same (last current 
page, possibilities to go back...)

Quit the application using the Web browser application menu: click on the key  .
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File Explorer Overview

To reach the File Explorer page

– On the Home page, select the File Explorer icon.

The File Explorer page appears.

Directories and Files selections

Directory
selection To select a directory from the explorer page:

1 Press on the directory that must be selected on the left of the screen.

The list of files the directory contains displays on the right side of the screen

The selected directory is underlined in blue

14-FILE MANAGEMENT
The files management with the FiberXpert OTDR 5000 can be performed, whether a module is set onto the 
FiberXpert OTDR 5000 or not.

The topics discussed in this chapter are as follows:

• “File Explorer Overview”
• “Directories and Files selections”
• “Directories & Files editing functions”
• “Working with directories and files from the explorer”
• “Creating a screenshot”
• “Creating a report”
• “Merging pdf or txt files”
• “Storage media”

Fig. 71 File Explorer page
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2 Click on the arrow at the left of the directory name, or press validation hard key,  
to display the sub-directories if any.

Files selection

To select one or several files from the explorer page:

1 Press on files that must be selected. or

To select a list of files using the keys of the Unit:

a Select and validate the first file of the list (underlined in red)

b Set the cursor on the last file of the list (underlined in blue)

c Maintain the right direction key pushed until all the files are selected. or

Click on Select all menu key to select all files into the directory.

NOTE
The last selected file is underlined in red and the previous one(s) selected is/are 
underlined in blue.

Directories & Files editing functions

Copy/Cut &
Paste files/
directories

To copy (cut) one or several files, or one directory, and paste them in another place:

Access to
sub-directory

Access to
sub-directory

Selected
files

Selected directory

Sub-directory

Fig. 68 Directory selection

Fig. 72 Example of files selection
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1 Select the directory / the file(s).

2 Press Edit menu key

3 Press Copy to keep the directory / file(s) to their initial location.

or, Press Cut to delete the directory / file(s) from their initial location

4 On the left of the screen, select the directory; or select the new storage media.

5 Click on Paste menu key.

Renaming a directory / file

1 Select the directory / file to be renamed

2 Press Edit > Rename Directory or Rename File.

The Edition keypad displays.

The selected directory is underlined in blue

3 Press Clear if you wish to delete the entire name

4 Enter a new name for the directory / file.

5 Click on Enter to validate the new name.

Deleting a directory / file

1 Select the directory or file(s) to be deleted

2 Press Edit > Delete.

A confirmation dialog box displays.

3 Press Yes to delete the selected directory or file(s).

Press No to cancel the deletion.

Working with directories and files from the explorer

Creating a
directory To create a new directory from the explorer page:

1 Check the cursor is set on the left of the screen

2 Select the storage media into which the directory must be created

Fig. 73 Edition keypad for renaming file
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3 If you want to create a sub-directory, select the directory into which it must be 
created.

4 Press the right menu key Create Directory.

The edition keypad displays

5 Enter a name for this directory

6 Press Enter key to validate the new directory

Opening files

Once a file is selected, press Load menu key.

Opening several files at the same time can be done exclusively with trace files 
(example: all OTDR trace files if a reference trace has been defined). Other type of files 
(PDF, TXT...) must be open one by one.

If different types of files have been selected in the Explorer, only the last one selected 
will open.

File Types

For files recognized by the FiberXpert OTDR 5000, the types are symbolized by icons. E.g.

Icon Type of FO file

OTDR file (.SOR extension)

Multi OTDR file (.MSOR extension)

Power Meter file (.LTS extension)

Icon Type of file

HTML file (.HTML extension)

PDF File (.PDF extension)

Text file (.TXT extension)

License file (.LIC extension)

CSV file (.CSV extension)

JPEG / JPG file (.JPEG extension)

PNG file (.PNG extension)

XML file (.XML extension)

With the FiberXpert OTDR 5000, you can open and load any kind of FO files (OTDR, 
LTS) even if the corresponding module is not set into the Unit.
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Sorting files

Whether files are selected or not, the key Sort allows to access to a sub-menu allowing 
to sort the file according to pre-defined parameters:

– Sort by name: the files display in an ascending order (from A to Z).

If you click once again on the key, the files display in a descending order (from Z to A).

– Sort by size: by clicking once on this key, the files display from the smallest to the 
heaviest one. Clicking a second time allows to sort the files in opposite order.

– Sort by type: clicking once on this key; the FiberXpert OTDR 5000 displays files in an 
ascending order (the file type A to file type W). By clicking again, the FiberXpert OTDR 
5000 displays the files in opposite order.

– Sort by date: clicking once on this key; the FiberXpert OTDR 5000 displays files from 
the more recent to the less one. By clicking again on key, the Unit displays files from 
the older to the more recent one.

NOTE
You can also sort files clicking on the column titles in the files list

Transferring files between two Units

If some Results traces or other kinds of file need to be transferred to another Unit, or 
if files from another Unit must be transferred to the FiberXpert OTDR 5000, this can 
be easily done using a USB cable.

Establishing connection between two Units

1 Connect the FiberXpert OTDR 5000 to another one, plugging the USB cable on the 
mini USB port of the Unit toward a USB port on the other Unit

Fig. 74 Direct connection FiberXpert OTDR 5000 <-> FiberXpert OTDR 5000

USB cable

Mini USB Port on the
FiberXpert OTDR 5000

USB port on the Unit
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2 Once connection is established, confirm that you wish to activate the USB link in the 
popup window on the FiberXpert OTDR 5000.

Transferring files

1 On the distant Unit, open the File Explorer page

The usbflash driver appears on the left side of the screen.

2 Select the file(s) to be transferred from one Unit.

3 Press Edit > Copy or Cut softkeys.

4 Select on the left of the screen, the directory on the other Unit, into which file(s) 
must be transferred.

5 Press Paste softkey.

File(s) is/are transferred.

Cancelling the connection

Once all desired files have been transferred, connection between both FiberXpert 
OTDR 5000s can be removed:

1 On the distant Unit, press Eject USB key before removing USB plug from connector.

2 On the FiberXpert OTDR 5000, remove the mini USB plug from its connector.

The screen displays the results trace of the active function, or returns to the Home 
page if no function is active.

Fig. 75 Confirmation of files export via USB cable
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Transferring files to a PC with the USB cable

If some Results traces or other kinds of file need to be transferred to the PC, this can 
be easily done using a USB cable.

Establishing connection 2000

1 Connect the FiberXpert OTDR 5000 to a PC, plugging the USB cable on the mini USB 
port of the Unit toward a USB port on the PC.

2 Once connection is established, confirm that you wish to activate the USB link in the 
popup window on the FiberXpert OTDR 5000.

A message displays on the bottom right side of the PC informing a new hardware is 
detected.

Fig. 76 Direct connection FiberXpert OTDR 5000 <-> PC

Fig. 77 Confirmation of files export via USB cable

Mini USB Port on
the 2000 Platform

USB port on the PC
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3 Click on the message and select «Open folder to view files» in the dialog box Softing 
IT Networks GmbH DISK (F:) («F:» is an example, it can be different according to your 
PC and to the USB port used).

The FiberXpert OTDR 5000 disk content opens onto the PC.

Transferring files onto the PC

1 Select the file(s) from the FiberXpert OTDR 5000 to be transferred onto the PC

2 Press Ctrl + C, or right click and select Copy.

3 On the PC, select the directory in which file(s) will be transferred.

4 Press Ctrl + V, or right click and select Paste.

Fig. 78 Open FiberXpert OTDR 5000 disk content

Fig. 79 Files selection from the FiberXpert OTDR 5000
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Cancelling the connection

Once all desired files have been transferred onto the PC, connection between 
FiberXpert OTDR 5000 and PC can be removed:

1 On the PC, use the appropriate method to safely remove the USB cable from the 
USB port.

The screen displays the results trace of the active function, or returns to the Home 
page if no function is active.

2 Remove the mini USB plug from the FiberXpert OTDR 5000 USB port.

Transferring files to/from a PC with a FTP server

It is possible, from a PC, to access the internal memory of the FiberXpert OTDR 5000 
or to the USB memory stick connected to the Unit by means of the FTP server of the 
FiberXpert OTDR 5000.

Direct
connection

1 Connect directly the FiberXpert OTDR 5000 Unit to the PC with an Ethernet cable, 
using the RJ45 connectors on each equipment.

Direct
connection 2 Make sure the network configuration onto the PC is set to the Dynamic mode:

a Click on Start > Control Panel.

b Double click on Network Connection.

c Double click on Local Area Connection.

d In the dialog box, click on Properties.

e Check the parameter Internet Protocol (TCP/IP) is selected ( ) and click once on it 
(underlined in blue)

f Click on Properties button.

g On the tab General, check the parameter Obtain an IP address automatically is 
selected ( ); if not, click to select it.

Ethernet cable

Ethernet cable

Fig. 80 Ethernet Connection FiberXpert OTDR 5000 <-> PC
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h Click on Ok and close all the dialog boxes opened onto the PC.

3 On the FiberXpert OTDR 5000 Unit, in the System Setup page, under I/O interface > 
Ethernet, select Dynamic.

4 Note the IP Address and wait for about ten seconds while the connection is 
established.

Connection via a local network

1 On the PC

– find the IP address and the mask of the PC’s sub- network

– With Windows NT, 2000, XP, Vista or 8: select Start > Programs > Accessories > Dos 
Prompt, type ipconfig”, then Enter.

NOTE
the IP address and the mask of the PC’s sub-network.

2 Plug the RJ 45 connector of the FiberXpert OTDR 5000 into a hub or Ethernet switch 
with a straight-through Ethernet cable

3 On the FiberXpert OTDR 5000:

In the system set-up menu, under I/O interfaces > Ethernet, select Config 1 (or 2 / 
3 / 4) on the line Mode, then enter the IP address, the IP mask of the PC and the IP 
gateway previously noted (step 1). or

Fig. 81 Internet Protocol

Fig. 82 System Setup > Ethernet: Dynamic mode

IP Address
of the Unit
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use Dynamic attribution mode (DHCP). In this case, the address of the FiberXpert 
OTDR 5000(10.33.18.235 in the example) is displayed but cannot be altered.

4 Wait for about ten seconds while the connection is established.

5 On the PC, make sure that the connection is operational by selecting Start > 
Execute... and typing ping followed by the address of the FiberXpert OTDR 5000.

Accessing the internal memory of the FiberXpert OTDR 5000

FTP access is obtained through the user account «fiberxpert5000» (password: PSIBER).

1 Make the FiberXpert OTDR 5000 / PC connection as described

2 On the PC, use an FTP client, and access to internal memory via an internet explorer 
(I.E, Mozilla Firefox...) or Windows Explorer.

3 In the address bar, type the following address (10.33.18.235, being the IP address of 
the FiberXpert OTDR 5000 defined when the connection was configured:

ftp://fiberxpert5000:PSIBER@10.33.18.235/disk/ This allows to access to internal 
memory.

ftp://fiberxpert5000:PSIBER@10.33.18.235/usbflash/ This allows to access to the 
contents of the USB memory stick

connected to the FiberXpert OTDR 5000.

The PC then displays the contents of the internal memory or of the

USB memory stick from the FiberXpert OTDR 5000.

4 If internal memory of the Unit is accessible via Internet Explorer (or any other 
explorer), right click on one file and click on Save target as... to transfer file onto the 
PC.

If internal memory of the Unit is accessible via Windows Explorer, select one / several 
files and click on Copy, then click on Paste on PC to transfer file.

Internal memory open via Internet 
Explorer

Internal memory open via Windows Explorer

Fig. 83 Internal memory of the FiberXpert OTDR 5000
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Creating a screenshot

You can create captures of what is displayed on the screen, directly from the 
FiberXpertOTDR 5000.

Configuring the parameters of screenshots

To configure the screenshot and choose the format of the generated file:

1 Press HOME hard key

2 Select the Settings icon to reach the System Settings page.

3 In the Report box, on the line Mode, select Screenshot

Choosing this option, you can save the displayed screen in JPG, PNG or PDF format, 
exactly as it is displayed on the screen.

Therefore, if you make a zoom on the trace for example, the file will only show the 
zoom section.

4 On the line File format, select if the printed file will be a JPG, PNG or PDF file.

Taking a screenshot

Once the screenshot parameters are configured:

1 Reach the display which will be saved as a screenshot in a file.

2 If necessary, make modifications on this display (example: zoom on trace...)

3 Press simultaneously the left and right arrow keys   for about 5 seconds or

Click on the upper banner of the screen and, in the virtual control buttons bar, press 
Export key

The icon  displays until the end of process.

4 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

Name of the screenshots files

The screenshot is saved in a file, which is automatically named as follow:

– Print_date (year/month/day)_time (hour/minute/second).jpg/png/pdf
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Creating a report

Once the results page of a function is opened (example: OTDR trace, Power Meter 
results...), it can be exported in a report, using the FiberXpert OTDR 5000 Unit.

Configuring the report

To configure the report and choose the format of the report file:

1 Press HOME hard key

2 Select Settings icon to reach the System Settings page.

3 In the Report box, on the line Mode, select Report.

Choosing this option, you can save the open file in a JPG, PNG or

PDF file report, exactly as if the file was printed on paper.

Therefore, if the file is too large for one A4 page, several JPG, PNG or PDF files will be 
created.

4 On the line File format, select if the report file will be a JPG, PNG or PDF file.

5 To display a Logo on the upper right of the report pages, click on Logo line and select 
the Logo to be displayed on the upper right of the page:

a Press to open the edition keypad

b Enter the path of the logo file with its extension (example: disk/Softing IT Networks 
GmbH logo.jpg)

c Press Enter to validate.

Fig. 84 Example of screenshot, open in the Web Browser of the FiberXpert OTDR 5000

Fig. 85 Example of Report configuration
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Creating the report

1 Open the file to be saved in a report in JPG, PNG or PDF format

2 If necessary, make the modifications on the file/trace (see user manual part of the 
OTDR Modules for OTDR trace files).

3 Set the trace view as wished.

For OTDR traces

– if the function is set to the Trace mode (Trace is selected on the menu key Trace/
Table/ Summary), the JPG/PNG/PDF file will contain the header and the trace (in one 
page).

– If the function is set to Table mode (Table is selected on the menu key Trace/Table/ 
Summary), the JPG/PNG/PDF file will contain the header, the trace and the entire 
results table (several pages may be required)

– If the function is set to Summary mode (Summary is selected on the menu key 
Trace/ Table/Summary), the JPG/PNG/PDF file will contain the header and the 
summary page, with either the Bend table or the Alarm Table according to the 
selected item with the menu key.

This view is only available with OTDR traces.

4 Press simultaneously the left and right arrow keys   for about 
5 seconds or Click on the upper banner of the screen and, in the virtual control 
buttons bar, press Export key

The icon  displays until the end of process.

5 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

The files are saved in the directory Print, on the disk media storage.

Name of the report

If a trace has been saved in a report file, the name of the JPG/PNG/PDF file is as 
follow:

– Name of the stored trace_date (year/month/day)_time (hour/minute/ second).jpg/
png/pdf

NOTE
If several traces are displayed in overlay, a different report file is generated for each 
trace open.
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Merging pdf or txt files

In the Explorer page, two pdf/txt files or more, generated via the results traces can be 
merged in one pdf file.

– The pdf files that can be merged are those generated via the Fast Report key on 
trace results page or via the Export key on the upper banner (or left and right arrow 
keys)

– The txt files that can be merged are those saved with the results trace (see OTDR 
Modules User Manual Part).

1 In the Explorer, select the two or more pdf/txt files generated

2 Press Export menu key

3 Press Merge key

The icon  is displayed during merging process.

After a few seconds, the files are merged in one pdf/txt file, which name by default is: 
merged_year_month_date hour_min_sec.pdf

Fig. 86 Example of report (in pdf)

Fig. 87 Files selection and Merge key
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The file is automatically saved in the same directory as the one where files have been 
selected.

It gathers all results from pdf/txt files selected (and traces for pdf file), in one single 
pdf file of several pages (1 results screen per page, if the results table does not exceed 
one page).

NOTE Once merged file is saved, it can be renamed in the Explorer

Storage media

For saving or recalling data, the FiberXpert OTDR 5000 offers a wide choice of media, 
both built-in and external.

Free space on selected media is clearly displayed at the bottom of the left panel.

Storage media built into the FiberXpert OTDR 5000

The FiberXpert OTDR 5000 is delivered with an internal memory, which maximum 
capacity is of 1GB (with a minimum of about 128 Mb are available for data storage).

Storage media built into the FiberXpert OTDR 5000

The FiberXpert OTDR 5000 is equipped with 2 USB ports as standard. One of these can 
be used to connect an external storage medium, in particular a USB memory stick.

NOTE
Although two USB ports are present, it is not possible to use simulta- neously more 
than one external USB storage medium.

USB memory stick connection

1 Insert the USB memory stick in one of the FiberXpert OTDR 5000’s USB port.

A sound is emitted to confirm the successful insertion and recogni- tion of a USB 
memory stick.

Then, the icon  is displayed in the upper banner to inform the user the USB stick is 
ready to be used.

When a file is moved in the explorer of the Unit, the end of the move on the screen 
does not mean that writing of data into the memory is complete. Some data may still 
be in a writing process if the storage unit is removed prematurely.

USB memory stick connection

1 Before disconnecting the USB memory stick, always select a storage device different 
from usbflash (select disk for example) in the explorer.

2 Make sure you no longer have any running applications using the usbflash storage 
media.

3 The user must push the EJECT USB key, available in File Explorer.

The icon becomes  to indicate it can be removed safely. In this state, the USB stick 
cannot be used anymore
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The USB memory stick can then be disconnected from the Unit’s USB port.

NOTE
The USB memory stick can also be removed using the Expert Tools

> Media Utilities menu, accessible via the System Settings page.

See “Maintenance and Troubleshooting” if any problem occurs with the USB memory 
stick

Cloud Storage

Principle and prerequisites of the Cloud Storage

The Cloud storage defined the outsourcing of data on distant servers, which avoid the 
data storage on a local workstation.

The cloud storage onto a FiberXpert OTDR 5000 allows to transfer the files from the 
Platform toward a distant server and vice-versa.

Before configuring the Cloud Storage on Platform, you must first create an account on 
a Cloud Platform on internet.

The Cloud storage function onto the FiberXpert OTDR 5000 works exclu- sively with 
sites using the WebDav technology such as CloudSafe (https://secure.cloudsafe.com/
pages/index. html) or Box (https:// www.box.com/pricing/).

Once account is created, with WevDav configuration, you get the following 
information for connection:

– URL

– Login Name

– Login Password

Configuring and connecting to Cloud Storage

Configuring the FiberXpert OTDR 5000

Once an account has been created on the Cloud site, configure the FiberXpert 5000 
Unit before establishing the connection:

Before configuring the Cloud Storage, make sure the configuration for Ethernet 
parameters and Proxy parameters are correctly configured.

1 On the Home page, press Settings to reach the System Settings page

2 In the I/O Interfaces windows, press Cloud Storage parameter

A new menu opens

3 In the Url parameter, enter the URL define for the Cloud server created on internet

4 In the User parameter, enter your Login created on your account

5 In the Key / Password, enter the password attributed by the Cloud server.
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Connecting Cloud Storage

Once configuration has been established on the FiberXpert OTDR 5000, it is ready to 
be connected with Cloud server:

Select one parameter of the Cloud Storage window on FiberXpert OTDR 5000

1 Press Connect Cloud Storage menu key . 

The connection launches

2 Once connection is established, a message displays in the window

3 Press any key to continue, and start files transfer.

The icon  is displayed on the upper banner as long as the connection is active.

Disconnecting from Cloud storage

To disconnect the FiberXpert OTDR 5000 from Cloud storage:

1 Press HOME hard key.

2 Select a parameter of the Cloud Storage window.

3 Press Disconnect Cloud Storage menu key.

Configuration on Cloud server
(example with CloudSafe)

Configuration on FiberXpert
OTDR 5000

Fig. 88 Example of configuration
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Transferring files using Cloud Storage

Once connection between FiberXpert OTDR 5000 and cloud storage server is 
successfully established, the files can be transferred from one Unit to the other.

1 Press HOME hard key.

2 Press FILE Explorer on the Home page

In the Explorer page, a new storage media is available: cloud- storage.

The cloud-storage media is not available when File Explorer is from a FO application.

3 Transfer the files from the disk or USB memory stick of the FiberXpert OTDR 5000 
Unit toward the cloud storage or vice-versa:

a Select the file(s) to be transferred

b Press the Edit > Copy or Cut menu keys

c Select the storage media (and the directory) into which files must be copied.

d Press Paste menu key

e Press Paste menu key

The cloud storage is automatically disconnected once the Unit is switched off. 
Reconnect from the System Settings page of the FiberXpert OTDR 5000 after the Unit 
restart.

Abbreviations for storage media

Abbreviation Storage medium

disk Internal flash memory

usbflash USB memory stick

Edition
menu

Fig. 89 File Explorer with cloud storage
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OTDR modules on FiberXpert OTDR 5000

Characteristics of reflectometry measurements

Distance
measurement – Dual cursor

– Distance displayed takes into account the calibration of the refractive index of the 
fiber.

– Index adjustable from 1,30000 to 1,70000 in steps of 0,00001

– Resolution of display: 1 cm max.

– Resolution of cursor: 1 cm max.

– Spacing of measurement points: from 4 cm, with up to 256 000 acquisition points.

– Accuracy: ± 1m± sampling resolution ±10-5 x distance (excluding errors of calibration 
of refractive index of the fiber).

– Display span: 3.25 m to 260 km

Attenuation
measurement – Dual cursor

– Resolution of display: 0,001 dB

– Resolution of cursor: 0,001 dB

– Linearity: ± 0.03 dB/dB with QUAD/MM Modules

– Display span: 1.25 dB to 55 dB

Reflectance
Measurement – Resolution of display: 0,01 dB

– Accuracy: ± 2 dB

15-TECHNICAL SPECIFICATIONS
This chapter contains the technical specifications of the FiberXpert OTDR 5000 mainframe.

The topics discussed in this chapter are as follows:

• “OTDR modules on FiberXpert OTDR 5000
• “Technical specifications of the Power meter function on module”
• “Technical specifications of the Source function on module
• “Display specifications”
• “Memory”
• “Input/Output”
• “Power supply”
•  “Dimensions - Weight”
• “Environment”
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– Automatic measurement of all the elements of the signal. Slope measurement by 
least squares or 2 points of measurement.

– Display threshold of faults:
- 0 to 5.99 dB in steps of 0.01 dB for event thresholds
- -11 to -99 dB in steps of 1 dB for the reflectance
- 0.01 to 5.99 dB in steps of 0.01 dB for attenuation

– Display of slope and attenuation for a segment of fiber.

– Display of the position of a fault and of attenuation.

– Display of the reflectance of the fault.

– Display of ORL

Manual Measurement

– Measurement of slope between the cursors.

– Measurement of attenuation between two segments of fiber.

– Measurement of reflectance of a reflecting element.

– Measurement of ORL between the two cursors.

– Measurement of splice by 2 or 5 points method

Typical specifications

Typical values, measured at 25°C unless specified.

Multimode / Singlemode OTDR Module

Central
Wavelengtha 850 / 1300 nm ± 30 nm

Typical RMS
Dynamic Rangeb 26 / 24 dB

Distance Range Up to 80 km

Pulse width 3 ns to 1 μs

Event Dead
Zonec 0.8 m

Attenuation
Dead Zoned 4 m

a. Laser in CW mode, at 25° C

b. Typical value corresponding to the difference (in dB) between the level of back-
diffusion extrapolated at the beginning of the fiber and the RMS noise level, after 3 
minutes of averaging, with the largest pulse width.

c. EDZ measured at +/- 1.5 dB below the peak of a non-saturated reflecting event at 
shortest pulse width.
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d. ADZ measured at +/- 0.5 dB on the basis of a linear regression using a -40 dB type 
reflectance, at shortest pulse width.

e. ADZ measured at +/- 0.5 dB on the basis of a linear regression from a reflectance of 
type FC/UPC (-55 dB) at shortest pulse width, at 1310 nm.

Class of the lasers of the OTDR modules

Module Standard EN 60825-1, Ed 1.2, 2001 -08 FDA21CFR§1040.10

Singlemode LA,
MA & MAE OTDR Modules Class1 Class 1

Singlemode MP OTDR
Module

Class 1M @ 1310 nm, Class 1 @ 
1490, 1550, 1625 & 1650 nm Class 1

Multimode OTDR Modules Class 1M @ 850 nm, Class 1 @ 
1300 nm Class 1

OTDR modules measurement

Weight: approx. 300 g (0,66 lbs) (400g for the QUAD OTDR Module)

Dimensions (in mm) - w x h x d: 128 x 134 x 41

Technical specifications of the Power meter function on module

Specifications given for 25°C, after 20 minutes stabilization time and after zero setting.

Power meter option for Multi/Single mode Modules

Ranges for Multimode Modules
3 ns 10 ns 30 ns 100 ns 300 ns 1 μs

0.5 km x x
1 km x x x
2 km x x x x
5 km x x x x x
10 km x x x x x x
20 km x x x x x x
40 km x x x x x
80 km x x x x
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Single / Multi mode Singlemode Power meter Multimode Power meter

Measurement Wavelength 1310 / 1490 / 1550 / 1625 / 1650 nm 850 and 1300 nm

Calibrated Wavelength 1310 / 1490 / 1550 / 1625 / 1650 nm 850 and 1300 nm

Input power range - 50 to - 2 dBm - 30 to -3 dBm

Maximum resolution 0.01 dB / 0.01nW

Linearity within the specification
range ± 0.5 dB (- 45 to - 5 dBm)

a Using a mode conditioner

Technical specifications of the Source function on module

– Laser Class 1

– Wavelength lasers at 25°C, depending on the wavelengths available in the module:

– 850 ± 20 nm

– 1300 ± 30 nm

– 1310 ± 20 nm

– 1490 ± 20 nm

– 1550 ± 20 nm

– 1625 ± 20 nm

– 1650 ± 20 nm

The wavelengths available for the source are the same as those available for the OTDR 
module.

– Spectral bandwidth: 5 nm RMS typical

Output level

– - 3.5 dBm typical for continuous signal (CW)

– modulated mean level: - 6.5 dBm typical

Emission mode

– Continuous signal (CW), not available for the 1650 nm wavelength on the MP OTDR 
Module.

– Signal including lambda information for the power meter (Auto).

– Modulated signal to identify the fiber (at 270 Hz/330 Hz/1kH/2kHz).

– Wavelengths activated one after the other (TwinTest mode).
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Display specifications

Screen – Backlight high visibility color touchscreen

– Size: 5 inches

– Resolution: 800 x 480 pixels

Memory

– Standard memory: internal memory, with a capacity of 1GB (with a minimum of 
about 125 Mb are available for data storage).

Input/Output

– two USB 2.0 host ports.

– one Mini USB 2.0 device

– one RJ 45 connector for Ethernet interface 10/100/1G

– built-in loudspeaker + headset jack

Power supply

Battery The instrument can be supplied with one Li-Polymer battery.

Endurance of the FiberXpert OTDR 5000 with battery

Measurement conditions:

– at +25 °C,

– at full battery capacity (4.5 Ah),

– FiberXpert OTDR 5000 equipped with one OTDR module

Standard Mains Adapter

Input 100-240 V, 50-60 Hz

Output 12V DC 2.5 A max

Compliance EN 60950

Endurance

Conditions of use Li-Polymer battery

According to Telcordia GR-196-CORE recommendation: 
Normal conditions, with normal backlight, 3 acquisition of 
30 seconds per quarter of hour, auto off

up to 8 hours

Under continuous acquisition, with high screen backlight:
- with an OTDR QUAD Module
- with an OTDR LM Module

Up to 3h
Up to 3h45
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Mains adapters

Supply or Power assigned in AC and in DC: 25 W

Dimensions - Weight

Weight

FiberXpert OTDR 5000 without options, battery nor module 692 g                      1.52 lbs

FiberXpert OTDR 5000 with a Li-Polymer battery and one OTDR LM Module 1.21kg                    2.67 lbs

Li-Polymer battery 172 g                      0.37 lbs

VFL/PWM option 30 g                      0.066 lbs

Dimensions (mm) (H X W X D)
Bumpers included

Dimensions (mm) (H X W X 
D) W/o bumpers

Without module 175 x 138 x 41 169 x 134 x 39

With 1 module 175 x 138 x 80  169 x 134 x 72

Environment

– Operating temperature range -20°C to +50°C (-4°F to +122°F)

– Operation including all options (guaranteed specifications) 0° to +40°C (+32°F to +104°F)

– Storage -20°C to +60°C (-4°F to +140°F)

Environment

– 5 to 95% without condensation

EMI/ESD

– CE class B Compliant (EN61326-1)

– FCC 47-1 Part 15 Compliant

Drop test

In accordance with the Telcordia GR-196-CORE recommendations, the FiberXpert 
OTDR 5000 resists the following test:

– 6 impacts dropped from a height of 1m on a pinwood floor of 5 cm thickness (1 
impact on each of its 6 sides, with power off).

Shocks

The FiberXpert OTDR 5000 resists the following test:

– 3 shocks per axis along each of the 3 axes, with power off.

– Impacts of 15g, 1/2 sine, duration 11 ms, at 10 second intervals.
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Bumps

The FiberXpert OTDR 5000 resists the following test:

– 1,000 bumps per axis along each of the 3 axes, with power off.

– Jolts of 15g, 1/2 sine, duration 6 ms, at 1 second intervals.

Vibration

The FiberXpert OTDR 5000 resists the following vibration tests:

– Complete test comprising 6 cycles along each of the x, y and z axes.

– One cycle of 5 to 200 Hz and back to 5 Hz with a sweep duration of one minute/
octave.

– 3 mm amplitude displacement test, for the range 5 Hz to 15 Hz.

– 3g acceleration test for the range 16 Hz to 200 Hz.

Flammability

The FiberXpert OTDR 5000 housing (in ABS, type V0) does not propagate fire.

Characteristics of the options

Power meter Specifications given for 25°C, after 20 minutes stabilization time and 
after zero setting.

– Wavelength range: 800 to 1650 nm in steps of 1 nm

– Calibrated wavelengths: 850 / 1310 / 1490 / 1550 / 1625 / 1650 nm1

– Accuracy at calibrated wavelengths: ± 0.2 dB (at -30 dBm)

– Input power range: -60 dBm to +10 dBm

– Maximum resolution: 0.01 dB / 0.01nW

– Measurement range:+5 to -50 dBm (+5 to -45 dBm from 800 to 1250 nm)

– Linearity within the measurement range: ± 0.2 dB

1.Specifications guaranteed to the calibrated wavelengths, except for 1650 nm
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Maintenance procedure

Maintenance work on this instrument must only be undertaken by qualified personnel using suitable 
equipment.

In most cases, it is advisable to contact the nearest Softing IT Networks GmbH 
Service Centre, which will undertake the appropriate troubleshooting and repair 
work. The performance and technical complexity of the FiberXpert OTDR 5000 class 
this instrument in a new generation of equipment, for which Softing IT Networks 
GmbH has laid down a maintenance policy based on the principle of standard 
module replacement. In implementation of this policy, we have set up powerful card 
trouble- shooting test resources in our factories and a rapid dispatch system operating 
between our factories and branches. Only by this procedure can the high quality of 
the instrument continue to be ensured after repair work. This procedure also has the 
advantage of reducing repair costs and time.

In the interests of quality and efficiency, we strongly recommend adop- tion of the 
following procedure in the event of a fault, before any other steps are taken:

– Verify that the instrument is plugged in.

– Check the connections of any peripheral equipment to the Unit.

– If a fault is detected, or in case of doubt, it is advisable to contact the nearest Softing 
IT Networks GmbH Service Centre, which will undertake the appropriate repair work.

Cleaning

Cleaning
plates and
housings

The front and rear plates and the housings may become tarnished with handling. 
To clean them, use only a rag moistened with soapy water. Never use any product 
containing acetone, trichlorethylene, benzine or alcohol, as these will attack the 
printed markings

Cleaning the
Screen To clean the screen, use an antistatic product.

Cleaning the
optical cable
connector

– Use a non-fluffy type of paper, such as Joseph paper, soaked in isopropylic alcohol.

16-MAINTENANCE AND TROUBLESHOOTING
This chapter describes how to maintain your unit and identify and correct problems related to the 
FiberXpert OTDR 5000.

The topics discussed in this chapter are as follows:

•  “Maintenance procedure”
•  “Recycling Information”
• “Troubleshooting” on page
•  “General information on warranty”
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Cleaning
the optical
connections of
the FiberXpert
OTDR 5000

– Squirt a highly volatile solvent (such as isopropylic alcohol) into the connector.
– Blow out the connector using a clean dry air supply from an aerosol can fitted with 
an extension.

NOTE
If your module has a universal connector, unscrew its adaptor to access the ferule.

Accessing the Unit Information

On the FiberXpert OTDR 5000, some screens allow to display information on different 
elements of the equipment.

To display the information on the FiberXpert OTDR 5000

1 On the Home page, validate Settings icon to reach the System Settings page.

2 On the right menu keys, press About to display the presentation screen of the 
FiberXpert OTDR 5000.

General page

The General page is displayed by default, and allows to display the presentation 
screen, with all the information concerning the software versions, the hardware 
options and the module installed.

This page shows:

– The software version information

– The product contents: base, optical options, battery type, touch- screen used, 
module installed and date of calibration for options .

The options set into the FiberXpert OTDR 5000 are marked with a green tick.

Software options page

This page allows to visualize the software options available on the FiberXpert OTDR 
5000 UnitPlatform.

1 Once on the About screen, press Software Options menu key to display the list of 
software options available on your FiberXpert OTDR 5000.

Fig. 90 General page
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Services Data page

This page allows to display information about the elements inside the FiberXpert 
OTDR 5000 (CPU, Memory, hardware revision, screen reference...).

1 Once on the About screen, press Services Data menu key to display the list of 
elements contained on your FiberXpert OTDR 5000.

Accessing Unit documentation

All documents necessary for the FiberXpert OTDR 5000 use are directly available onto 
the equipment.

To display the list of documents available for FiberXpert OTDR 5000 use:

1 Validate the Help icon on the Home page.

2 In the page, click one link to display the corresponding document: User manual, 
Getting Started Manual, Quick Card...

Fig. 91 Software Options page

Fig. 92 Services Data page
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Installing a new version of the software

When a new software version is loaded, there is a risk of re-initializa- tion of the 
internal memory. Before installing the new software, it is therefore advisable to save 
the results in the memory, using the Save function called up by the FILE button.

Do not interrupt the installation process, as this could damage the instrument.

To avoid any interruption of the installation procedure, the FiberXpert OTDR 5000 
Unitmust be operating on the mains: if the procedure is started while operating on 
battery, a message indicates that the instrument must be connected to the mains.

Downloading from Internet

When the software is obtained from the Internet, it must be saved on a storage 
medium before the software upgrade of the product can be carried out. To do this:

1 Open Internet Explorer

2 On the Softing IT Networks GmbH web site (http://itnetworks.softing.com), 
open the page of the product concerned – FiberXpert OTDR 5000

3 Click on the tab Downloads.

4 Click on the link FiberXpert OTDR 5000 Firmware Update

A new page opens, displaying the current version available and several links.

5 According to your region, click on the one of the following icon to download the 
archive.

 Download from European server
 Download from North American server
 Download from Asian server

6 In the new dialog box displayed, click on Save to save the exe file on the PC.

7 Once completed, connect the USB memory stick to the PC and follow the 
instructions chapter “Installation from a USB memory stick”

Software versions
installed on Unit

Software versions
available on selected
media for update

Fig. 93 Software Upgrade
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Installation from a USB memory stick

You must be equipped with a USB memory stick with a minimum capacity of 128 MB.

Before installing the upgrade, you must format the USB memory stick

1 Once formatted, disconnect the USB memory stick from the FiberXpert OTDR 5000 
Unitusing the key Eject USB in the Media Utilities page.

As for any media formatting, please note that all data present on the USB memory 
stick willbe irremediably lost.

2 Connect the USB memory stick to the PC

3 Unzip the upgrade files on the PC and transfer it to the USB memory stick:

a Download and save on your PC the.exe upgrade file that you can get from the web 
(http://itnetworks.softing.com)

b Once the transfer is completed, double click on the.exe file: A window will appear. 
Checkthat the folder is correct i.e. the USB memory stick driver is appearing in the 
line at thebottom of the dialog box then press OK. If not, click on the icon in order to 
select the rightUSB drive.

c Press OK and wait for the end of loading.

4 Then remove the USB memory stick, using the appropriate proce- dure, from your 
PC

5 Insert the memory stick into one of the USB ports on the Unit.

NOTE A bip is emitted each time the USB memory stick is inserted or removed from 
the USB port.

6 Press successively Expert Tools > Upgrades > Software Upgrade > Upgrade from USB.

The message Are you sure? is displayed

7 Click on Confirm.

The list of the software versions available on the USB stick is displayed next to the 
versions installed on the FiberXpert OTDR 5000.

Fig. 94 List of software update
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Launching the upgrade

Whatever is the method selected for upgrade (Server, USB key...) and once the list 
of the software versions available is displayed next to the versions installed on the 
FiberXpert OTDR 5000 follow these instructions to launch the upgrade:

1 Click on Show Prev choice or Show Next Choice to display the previous and next 
versions available.

2 Click on Confirm this Choice to start the upgrade of the selected software(s).

or

Click on Confirm All Choices to upgrade all versions.

NOTE
The software versions list does not always appear (cf previous ver- sions) as well as 
the Previous / Next Choice buttons and the Con- firm/Continue key. In this case, the 
upgrading starts automatically.

Upgrading begins. The FiberXpert OTDR 5000 is automatically rebooted. Upgrading 
takes several minutes. Finally, the FiberXpert OTDR 5000 is automatically restarted.

During the upgrade, the Testing indicator is lit in red. Do not push any button or 
remove the USB memory stick while the indicator is lit. The USB stick can be removed 
if necessary once the Testing indicator is off.

Characteristics of the options

This method is used to make a complete reinstallation of the software versions.

1 Turn off the FiberXpert OTDR 5000 using the ON/OFF button, keeping the equipment 
connected to the mains.

2 Insert the USB stick onto which the software versions are stored into one of the USB 
port of the Unit

3 Press simultaneously SETUP + START/STOP buttons

4 Maintaining the two buttons pressed, press ON button to start the FiberXpert OTDR 
5000.

5 A menu displays, then the screen allows to select Upgrade from USB

After a few seconds, a new page displays indicating that to continue the reboot, the 
validation key must be pressed.

Press the hard key.

The reboot starts automatically.

The Testing indicator will be lit in red during upgrade. Do not push any key or remove 
the USB memory stick until the lit turns off.

Once the upgrade is completed, the FiberXpert OTDR 5000 will automatically turns on 
and display the Home page.
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Install Option

This page allows to import the licence to get a software option.

To import the license, you can either enter manually the licence code, given in the 
license file, (.lic file) or import this file with a USB memory stick connected to the 
FiberXpert OTDR 5000.

It is strongly recommended to perform the installation using the importation of 
Licence via a USB memory stick.

Enter Manually the Licence

1 In the Home page, click on Expert Tools > Upgrades > Install Option > Enter License

The edition keypad is displayed

2 Enter the challenge code of the option, set at the bottom of the file

Fig. 95 Example of a License file (.lic)

Licence
Code
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The license file can be opened via a word processing software such as Word...

The challenge code must be entered exactly as it is in the .lic file, paying attention to 
the lower-case and upper-case letters etc.

3 Press the Enter key to validate the code

Your software options will be installed

At the end of this sequence you will be asked to reboot the unit to apply the 
modifications, pushing the key . Confirm the reboot to restart the Unit. 

Import the license from the USB memory stick

1 In the Home page, select the Settings icon

2 In the System Settings page, press Expert Tools > Upgrades > Install Option > Import 
License

If the USB memory stick is not already connected to the Unit, a message asking the 
memory stick insertion is displayed. Confirm it once the stick is connected.

3 In the File Explorer, select the USB stick, then the license file (.lic) to be imported,

4 Click on Load > Confirm

5 The challenge codes contained in this file will then be loaded auto- matically and 
your software options will be installed

Fig. 96 Enter the Licence code
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6 At the end of this sequence you will be asked to reboot the unit to apply the 
modifications, pushing the key  .

7 Confirm the reboot

Locking the FiberXpert OTDR 5000

The FiberXpert OTDR 5000 can be locked at any time:

1 In the HOME page, click on Expert Tools

2 Click on Instrument Lock Out

3 Confirm the FiberXpert OTDR 5000 locking by clicking on Confirm (or use the Cancel 
key to cancel the process).

The numeric keypad is displayed

4 Enter the password to lock the instrument: 42000 with the numeric keypad 
displayed.

5 Click on Enter

The FiberXpert OTDR 5000 locking screen is displayed.

Fig. 98 Passw ord

Fig. 97 License imported
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Click on the Notepad Message key to add a message using the text edition.

Unlocking the FiberXpert OTDR 5000

1 Once the locking screen is displayed, click on the key Unlock Instrument.

2 Press confirm to confirm the Unitmust be unlocked.

3 Enter the password 42000 using the numeric keypad displayed and validate.

The screen automatically displays the HOME page.

Returning an instrument

To return an instrument get in contact with Softing IT Networks GmbH to follow the 
appropriate RMA process

When returning an instrument, it is essential to indicate the following minimum 
information:

– the type and serial number of the instrument (on the identification label) and the 
configuration code (under the bar code)

– a description of the fault found on the instrument.

The returned instrument will then be repaired and calibrated.

Guarantee conditions

Any repair operation supervening within the guarantee period of the instrument 
will be carried out at the expense of Softing IT Networks GmbH. However, for any 
sub-assembly upon which work has been carried out otherwise than by Softing IT 
Networks GmbH Service Centers, the cost of a replacement sub-assembly will be 
invoiced.

Recycling Information

Softing IT Networks GmbH recommends that customers dispose of their instruments 
and peripherals in an environmentally sound manner. Potential methods include reuse 
of parts or whole products and recycling of products components, and/or materials.

Fig. 99 Locking screen
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Waste Electrical and electronic Equipment (WEEE) Directive

In the European Union, this label indicates that this product should not be disposed 
of with household waste. It should be deposited at an appropriate facility to enable 
recovery and recycling.

Troubleshooting

Troubleshooting Solution

Nothing happens when the ON/ OFF key is pressed. - Make sure that the battery is present or charged; 
or the mains adapter is properly connected

Nothing happens on screen, whatever is the action 
done (menu key or hard key pressed...) - The Unit must be rebooted.

You are using the FiberXpert OTDR 5000 in the 
ordinary way when it suddenly switches off.

- Check the instrument is not configured to Auto off. 
See
- Check the battery charge level.

The battery refuses to charge (the Charge indicator 
does not go on when the instrument is connected 
to the mains and is not operating).

- There is no battery in the instrument.
- The temperature level of the equipment does not 
allow the battery charging for safety reasons. Wait 
the equipment cools down.
- The battery needs to be changed.

When using the touchscreen, nothing happens The touchscreen needs to be calibrate.

Troubleshooting Solution

Error message when USB has been disconnected

- The USB disconnection has not been done 
properly
- The data transfer was not completed when USB 
key was disconnected.

No beep is emitted when the USB memory stick is 
connected

- A previous USB memory stick has not been prop- 
erly disconnected
- The USB memory stick is not detected by the 
FiberXpert 5000 Unit: use another memory stick, 
or another storage media; or transfer data via USB 
cable

Error message when upgrade via Ethernet is 
confirmed - Check the Server Name is correctly entered

Error message when upgrade via USB key is 
confirmed - Check the USB key is correctly connected

Error message when unlocking the instrument - The password is not the correct one

Formatting the USB memory stick onto the FiberXpert OTDR 5000

If the USB icon  is displayed on the upper banner of the screen, when a USB 
memory stick is connected to the FiberXpert OTDR 5000, this may means the memory 
stick must be formatted.
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If the stick needs to be formatted, proceed as follows:

1 Insert the memory stick into one of the USB port on the top of the FiberXpert OTDR 
5000.

2 Press the HOME button

3 Validate the Settings icon to open the System Settings page.

4 On the right menu keys, successively select Expert tools > Media utilities > Usbflash 
Format.

5 Confirm your choice to actually format the USB memory stick.

As for any media formatting, please note that all data present on the USB memory 
stick will be irremediably lost.

Erase disk

To delete all the disk contents of the FiberXpert OTDR 5000:

1 On the Home page, Press twice the Settings icon to open the System Settings page

2 Press Expert Tools > Media Utilities,

3 Select Erase Disk to delete all the disk contents into the FiberXpert OTDR 5000 Unit.

A confirmation must be validated before the deletion.

Touchscreen calibration

If you meet problems when using the touchscreen (example: pressing on an icon does 
not work correctly...) a calibration can be performed on the FiberXpert OTDR 5000 
touchscreen.

To calibrate the touchscreen, proceed as follows:

1 Push the HOME button

2 Press twice the Settings icon to open the System Settings page.

3 Press Expert Tools menu key

4 Press Touchscreen Calibration key

A blue slightly smaller screen appears, displaying a little target on the left hand corner.

5 Click on this target (preferably with the touchscreen pen).

6 A new target appears then and again, for a total of 4 times, in order to click on all 
corners of the screen.

If all the targets are not correctly touched, the touchscreen cannot be used. 
Otherwise, the touchscreen may be used directly.
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Changing the battery

If you meet problems during the Unit functioning, or if the battery does not charge 
anymore when plugged, this may require the battery to be replaced.

CAUTION
Battery is not interchangeable in the field. It must be replaced by Softing IT Networks 
GmbH. Please contact support.

Target

Fig. 100 Touchscreen calibration
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Erase disk

The warranties described herein shall apply to all commercially available Softing 
IT Networks GmbH products. Any additional or different warranties shall apply 
only if agreed to by Softing IT Networks GmbH in writing. These warranties are not 
transferable without the express written consent of Softing IT Networks GmbH.

Hardware Warranty

Softing IT Networks GmbH warrants that Hardware Product sold to customer shall, 
under normal use and service, be free from defects in materials and workman- ship. 
Information regarding the specific warranty period for this product can be obtained 
by contacting your local Softing IT Networks GmbH Customer Service Representative, 
or at our web site http://itnetworks.softing.com. If installation services have 
been ordered, the warranty period shall begin on the earlier of (1) completion of 
installation, or (2) thirty (30) days after shipment to customer. If Installation Services 
have not been ordered, the warranty period shall begin upon shipment to Customer. 
Hereafter these periods of time shall be collectively referred to as the Initial Warranty 
Period. Softing IT Networks GmbH ’s obligation and customer’s sole remedy under this 
Hardware Warranty is limited to the repair or replacement, at Acterna’s option, of the 
defective product. Softing IT Networks GmbH shall have no obligation to remedy any 
such defect if it can be shown: (a) that the Product was altered, repaired, or reworked 
by any party other than Softing IT Networks GmbH without Softing IT Networks 
GmbH’s written consent; (b) that such defects were the result of customer’s improper 
storage, mishandling, abuse, or misuse of Product; (c) that such defects were the 
result of customer’s use of Product in conjunction with equipment elec- tronically 
or mechanically incompatible or of an inferior quality; or (d) that the defect was the 
result of damage by fire, explosion, power failure, or any act of nature. Softing IT 
Networks GmbH performed repairs shall be warranted from defective material and 
workmanship for a period of ninety (90) days, or until the end of the Initial Warranty 
Period, whichever is longer Risk of loss or damage to Product returned to Softing IT 
Networks GmbH for repair or replacement shall be borne by customer until delivery 
to Softing IT Networks GmbH.Upon delivery of such product, Softing IT Networks 
GmbH shall assume the risk of loss or damage until that time that the product being 
repaired or replaced is returned and delivered to customer. Customer shall pay all 
transportation costs for equipment or software shipped to Softing IT Networks GmbH 
for repair or replace- ment. Softing IT Networks GmbH shall pay all transportation 
costs associated with returning repaired or replaced product to customer.

Warranty disclaimer

For hardware and/or services furnished by Softing IT Networks GmbH, the foregoing 
warranties are in lieu of all other warrantees and conditions, express or implied. 
Softing IT Networks GmbH specifically disclaims all other warranties, either express 
or implied, on any hardware, documentation or services including but not limited 
to warranties relating to quality, performance, noninfringement, merchantability or 
fitness for a particular purpose, as well as those arising from any course of dealing, 
usage or trade practice. under no circum- stances will Softing IT Networks GmbH be 
liable for any indirect or consequential damages related to breach of this warranty.
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